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Welcome to our help file. If you're looking for help with a particular problem, we suggest you 
start at the Help Contents page. This section is more or less a philosophical overview of 
Acoustica CD/DVD Label Maker. If you're leaning forward in your chair right now, pupils 
dilated, mouse in a deathgrip, all because of something you haven't been able to figure out 
how to do - see the Help Contents. WelcomeIf you're reclining peacefully, with a comforting 
beverage beside you and perhaps one hand thoughtfully stroking your chin - read on. 
 
Our Goals 
 
Acoustica's mission is to make fun, quality, easy to use software. We want Acoustica CD/DVD 
Label Maker to be a program that never makes you want to swear at your computer or throw 
your monitor out the window. We want to help you get your CD labels made quickly and enjoy 
doing it. And we want to help you bring out your creative side, even if you don't think you have 
one.  
 
One of the first things we realized is that if you want to be able to get where you need to go 
and try all the things you want to try, you need to have your tools handy. You don't want to 
have to weed through menus and nested subdialogs and hieroglyphic-laden, randomly 
arranged toolbars to get at the image or tool you're looking for. When you were four years old 
and you set out to color a picture, you set your paper in front of you and dumped all your 
crayons out beside it. Everything you needed was in easy reach. You didn't put all your red 
crayons in one of the kitchen drawers, your blue crayons in a box in the attic, and your green 
crayons under the bed at your friend's house across town. That would have been stupid. That 
would have been the sort of thing that - and I blush to say so, because I belong to this category 
- a programmer would do. We've tried to avoid the programmer's way and, instead, keep all 
your tools just a click away so the program doesn't get in the way when you're in a creative 
trance (you're in those all the time, right?). For more details on our approach to tools and 
general program layout, see Getting Around in Acoustica CD/DVD Label Maker. 
 
Our Process 
 
"The best way to have a good idea is to have lots of ideas." 
     --Linus Pauling 
 
My fellow Acousticans loved it when I brought in a new version of the program with some 
important new feature. They seemed to think it was one of those carnival booths where you 
throw darts at the rows of balloons until you pop the one with the prize behind it. "I don't think 
this is clear," one of them might say. (Pop!) "It's too hard to find this button," might say another. 
(Pop!) "You need to be a techie to figure this out," a third might add. (Pop! Pop! Pop!) 
Eventually, having reduced the program to rubble, we'd agree on what seemed to be the 
clearest, simplest way to access whatever feature we were adding, and I'd head back to my 
code editor. I soon figured that I could shorten this process by making us all argue over how to 
add a feature before I wrote a version to try. This would be like having my Acousticohorts help 
set up the booth, so that they knew beforehand which balloon hid the prize. Surely this would 
reduce the carnage. But you know what? It didn't change a thing. The same people who swore 
oaths over the best way to arrange the tabs in the print dialog would violently disagree as soon 
as they saw it in action. Some things, it would seem, like program interfaces and living room 
paint colors, just have to be tried out before you know what works. 
 
And so, at least partly because of this, it's taken more than a year to bring this program to you. 
Not that I'm complaining. The painstaking process we've gone through has helped us create a 
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program that, I think, makes it easier, quicker, and more fun than it's ever been for you to 
create labels you like. Without the feedback and ideas I received throughout the process, the 
program would be nowhere near what it is today. So thanks, Joseph, Ronnie, Lois, Brian, 
Donda, and the beta team. Please ask your nearest neighbor to pat you on the back. 
 
So It's All Done Now? 
 
Think back to all the bestselling novels you've written. Once they hit the bookshelves, you 
were done with them. Perhaps you received fan mail that said, "I just adored your book. I'd 
mow your lawn with tweezers if I could only have a tithe of your talent. And by the way, if 
Kermit the Pirate had a peg leg in chapter three, shouldn't he have succumbed to the pack of 
rabid unicycle beavers in chapter eleven?" And you'd think, "Hey, that's right!" But there was 
nothing you could do about it now. It was out of your hands. 
 
We don't have that problem. We can keep releasing new versions as long as enough of our 
users register the software that we can afford to keep doing so. If one of our users - you, for 
instance - find a bug or have a great idea, we can improve the program. As long as you tell us, 
that is. If you notice a way to make the program simpler, or there's a feature you really, really, 
really want, let us know. Your suggestion might find its way into the program. That sort of thing 
doesn't happen in many places. No matter how many touching letters you write to William 
Shakespeare, he won't change Romeo & Juliet to let the poor kids wake up in time and get 
married after all. No matter how much you threaten Leonardo Da Vinci, he won't add a 
moustache to the Mona Lisa. With us, you have a chance. We make no guarantees, but we do 
listen to our users, and we like to hear from them. Without them, after all, we wouldn't be here.
 
Enjoy Acoustica CD/DVD Label Maker; we hope it helps you find your inner cd label making 
artist. 
 

 
Acoustica CD/DVD Label Maker programmer 
 
Help Contents  
 
 
 
Getting Around in Acoustica CD/DVD Label Maker 

 
 
We've split the program's main window into two pieces: on the left, tools or ingredients; on the 
right, your actual labels (or, if you like the ingredients metaphor, "stew"). It's set up this way 
because it's hard to concentrate when the tools you need aren't handy. When we want to try 
out a new background on a label, we don't want to launch a file-open dialog, search for the 
right directory, select an image, and close the dialog. That's way too much work to repeat for 
every single background we might want to look at. We want our backgrounds and clip art and 
so forth available all the time, so we can try out new ones without having to organize a search 
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party.  
 

  
 
Consequently, there's a row of tabs along the top-left side of the program, labeled, 
respectively, "layouts", "backgrounds", "art search", and "art browse". Clicking on one of the 
tabs brings up one of the categories of stuff you can add to your label. Clicking on 
"backgrounds," for instance, brings up a list of little thumbnailed images of all the built-in 
backgrounds you can add to your currently selected label. Click on a background, and it 
becomes your label's background. Click on another one (or use the arrow keys to select 
another one), and now it becomes your label's new background. We think that's pretty 
straightforward. 
 
Hiding the Tools Window 
 
Of course, you may be the type who can't abide distractions. "How can I concentrate on 
perfecting the elements I've already chosen for my label," you may say, "if I've got all these 
other backgrounds and clip arts tempting me?" I know I tend to be this way in chocolate shops. 
So if you want the tools window to go away altogether, you can click on the left arrow button 

 at the bottom of the window. This will make the labels window take up the entire screen. 
Once you do this, the left arrow button will turn into a right arrow button; clicking on it will bring 
the tools window back again. 
 
Making the Tools Window Bigger or Smaller 
 
Perhaps you want, like me, to have your tools window visible, but you find the cosmic balance 
between the yin of tools and the yang of labels (or vice versa) is a little off, and you'd like a 
little more or less of the tools window. This is easily solved. When you want your tools window 
to be bigger or smaller, you can click on the border between the tools and labels windows and 
drag it to size things however you want them. The mouse cursor will change into a little 
horizontal resizing arrow whenever it's over the border. 
 
The Label Tabs 
 

  
 
If you've ever wondered, "How do I edit all the different labels that a CD has?" or "What's that 
row of tabs along the upper right hand side of the window for?", then you've come to the right 
paragraph. The row of tabs above the labels window corresponds to the different label faces 
you can design. Clicking on a tab will bring its respective label to the foreground so you can 
play with it. Clicking on a label tab will also change the tools/ingredients windows to display the 
available backgrounds and layouts for the new foreground label. 
 
The "Display Tracks" Button 
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We presume that your CD or DVD has something on it. Not many people make CD labels for 
blank CDs - although if that's what you're doing, we certainly have no objections. And not 
many people want to type in their tracks list once to display on their disc label, and once again 
for the front of their jewel case, and once again for - well, you get the idea. We've created a 
special Tracks lThe_Tracks_Windowist so that you can just type in your tracks list once (or let 
the program import it for you, if you've got a playlist file), and then display it on whichever 
labels you like. If you click the Show Tracks button, the program will display your tracks list on 
the current label. If you click it again, Acoustica CD/DVD Label Maker will hide your tracks 
information. For more information, see the Displaying Text sDisplaying_Textection. 
 
Help Contents 
 
 
 
 
Text 

 
 
Displaying Text 
 
Text Properties Dialog 
 
The "Edit Text" Window for Angled or Curved Text 
 
The Tracks Dialog 
 
 
Help Contents  
 
 
 
Displaying Text 

 
 
To display text on a label, create a text object. You can do this by clicking the "new text" button 
on Acoustica CD/DVD Label Maker's main toolbar or by selecting the "Create a new text 
object" item from the Text menu.  
 
One of the biggest quandaries we faced when we were designing the text object control was 
how to tell whether you clicked on the text control because you wanted to edit the text or 
because you wanted to move the whole blooming object somewhere. It's a sticky issue. We 
didn't want to make you go through a series of contortions to switch between object-moving 
and text-editing modes. We wanted text editing and object moving and resizing to be available 
at the same time. Here's how we dealt with it: 
 
When you left-click on an unselected text object, it will select the object. The object will grow a 
title bar, a frame, and a set of resizing bars. If you only wanted to move the object, don't 
release the mouse button - you can drag the object anywhere you like until you release the 
mouse button. Once you release the mouse button, the program will insert a text editing caret 
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next to the text you clicked on. 
 
Once a text object is selected (it's got the title bar and resize bars), clicking on the text will no 
longer let you move the object; instead, it will place the text-editing caret next to the text you 
clicked on. If you want to move the object once it's selected, you can do so by clicking on the 
text object's title bar and dragging it around. 
 
Clicking on a text object's title bar will not just let you move it; it will also cause the object to go 
into "object mode." The editing caret will disappear, and any keystrokes you make will apply to 
the object itself instead of the text inside it. If you press the Delete key while you're in object 
mode, the entire text object will disappear. If you press Ctrl-x or Ctrl-c, the object will get cut or 
copied, respectively. Pressing the arrow keys will move the object. Clicking anywhere inside 
the text object will take you out of object mode and back into the normal text-editing mode. 
 
Regardless of what mode a text object's in, once it's selected, you can resize it by clicking on 
any of the little red resize bars scattered around its border and then dragging them.  
 
The Text Object Toolbar 
 

  
 
When you click on a text object, a toolbar should appear directly underneath it. If it doesn't, 
click on the "T" button on the object's toolbar. The buttons on the toolbar serve these functions, 
from left to right: 
 
* Setting the typeface 
* Setting the font size 
* Setting the text color 
* Toggling the bold text effect on and off. 
* Toggling the italics text effect on and off. 
* Launching the text properties dialog,The_Text_Properties_Dialog which lets you edit a 
veritable encyclopedia's worth of text properties. 
* Editing the object's text (only shows up on the toolbars of  text objects with text angles other 
than 0 degrees). 
 
Except for the last two buttons, which launch dialogs, all these buttons apply to whatever text 
you've currently got selected. If you don't have any text selected, changes you make with 
these buttons will apply to all the text in the text object. This is a different behavior from the 
majority of text editing programs, which assume that if you don't have any text selected, 
changes you make don't apply to any text at all - a behavior that, quite frankly, baffles us. If 
you put a CD into the stereo and press the play button without selecting a particular track to 
play, your CD player doesn't ignore you - it starts at the beginning and plays the whole CD. If 
you walk into a bar and ask for a beer, the bartender won't pretend he didn't hear you just 
because you didn't tell him how full you wanted the glass. And if you click the bold button 
without any text selected, we're pretty sure you don't mean, "act as if I don't exist." You mean 
to change text to bold. And that's what we do for you. 
 
Special Stuff You Can Do With Tracks/Contents Text Objects 
 
Track lists (lists of the track names, artist names, etc. on your CD) are a special type of text 
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object. You don't need to create new text objects to display them. Instead, either select a 
layout that has a tracks list, or open the tracks dialog (by clicking the "tracks" button on the 
toolbar) and check the "Display tracks on current label" button. 
 
When you edit the text in a tracks list object, the changes will get relayed to all the other label 
faces in your current file. So if you've got tracks list text objects on all your labels, editing the 
disc label to change the title of song 1 from "Let the Good Times Ambulate" to "Let the Good 
Times Roll" will cause the title to change on the front, inside, and back labels as well. Changes 
you make to the text by editing it in the Tracks Dialog The_Tracks_Windowwill also get sent to 
all the labels. 
 
Formatting changes - fonts, italics, etc. - will not get sent to other labels. Only changes to the 
actual text will get passed on to the other labels. In addition, changes to the track number field 
won't get sent to the other labels. If you make a mistake and mess up one or more of the track 
number fields, hiding and showing the tracks objects field (which you can do from the Tracks 
Dialog) The_Tracks_Windowwill cause the tracks to get renumbered. 
 
The Tracks List Header Bar 
 
When you select a tracks text object, you should see, in addition to the traditional title bar, 
sizing frame, resize bars, and toolbar, a columns header bar. The header bar has these 
functions: 
 
* Left-clicking on a header bar column will select all the text in that column, so that you can 
apply whatever column-wide effects strike your fancy. 
 
* Left-clicking on the border between columns and dragging it will allow you to resize columns 
(in fixed-width columns mode) or the space between columns (if you're in variable-width 
columns mode). 
 
* Right-clicking on the header bar will pop up a menu that lets you hide and show individual 
columns and toggle between fixed-width columns and variable-width columns modes. 
 
Fixed Width vs. Variable Width Fields 
 
In fixed-width mode, all rows of a field will be the same width. If you set the "track name" field 
to be 2.5 centimeters wide, every track will have a 2.5-centimeter-wide track name. All rows 
will line up exactly underneath each other, like the rows in a spreadsheet or a table in a word 
processor. 
 
In variable-width mode, each column of each row will be exactly as wide as required to display 
the amount of text. The title for "You've Certainly Got a Lovely Bunch of Coconuts" will be 
wider than the title for "Louie Louie." The rows in the text object will not line up directly 
underneath each other, unless all their text fields happen to be exactly the same length. 
 
However, in variable-width columns mode, there will be a fixed amount of space between 
columns. If you specify 1.2 centimeters after the track number column, every row will have 1.2 
centimeters of blank space between its track number and the field that follows it, no matter 
how wide individual track numbers may be. When you're in variable-width columns mode and 
you drag the column borders in the header bar, you're actually editing the width between the 
columns rather than the widths of the columns themselves.
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Fixed width columns work well for left-justified text or cases where you've got more than two 
columns visible. The variable width columns setting can have a nice effect on centered or right-
justified tracks listings. 
 
If the header bar has a blank section before the first column, it's nothing to worry about. It just 
means that you've got the text object in centered or right-justified mode. 
 
The Text Properties Dialog 
 
Help Contents  
 
 
 
The "Edit Text" Window for Angled or Curved Text 

 
 
When you set a text object to an angle (see the Text Properties Dialog "Text Angle" Page) 
that'sText_Properties_Text_Angle_Page sideways or upside down, you won't be able to edit it 
by just clicking on the text object, the way you normally do. While I was writing the program, I 
tried editing text sideways and upside down, but I had a roaring headache within a minute. I 
don't wish to cause pain to any of our users, so I added a right-side-up editing window to use 
when your text isn't upright. When you set your text to be sideways, upside down, curved, or 
spiral, the text object's toolbar will grow a new button, away off to the right side:  
 

  
 
Click on the  button and the program will launch a window like this one: 
 

  
 
You can edit your text in this window. Any changes you make will show up back on your label 
as soon as you close the window. (You can close the window by clicking on the X in the upper 
right hand side of the window's title bar.)
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Help Contents  
 
 
 
Clip Art 

 
 
Art Search 
 
Art Browse 
 
Stuff You Can Do With Clip Art 
 
 
Help Contents  
 
 
 
Stuff You Can Do WIth Clip Art 

 
 
When you see a clip art image in Acoustica CD/DVD Label Maker, you will be looking either at 
a hopeful thumbnail under the Art Search or Art Browse tabs, or a proud, happy clip art image 
that you have added to one of your labels. The actions you can take differ depending on which 
of these two situations you're facing.  We'll start with: 
 
Stuff You Can Do with a Clip Art Thumbnail in the Art Search or Art Browse Tabs 
 
* You can drag your mouse cursor over it and just let it sit there. This will cause a tooltip to pop 
up and tell you the clip art image's name, folder location, size, and date and time when it was 
last modified. 
 
* You can left-click on it and drag it onto your label.  
 
* You can double-click it. This will make it your label's background image. 
 
* You can right-click it, which will pop up a menu with these options: 
 
Set as Background: this will bring up a submenu with these options: 
 
1. Centered (overlap): make the selected clip art image your background image, and center it 
on the label. This will cover the entire label with the selected image while preserving the 
image's aspect ratio. If the image's aspect ratio differs from the label's aspect ratio, a portion of 
the image will get clipped. 
 
2. Centered (underlap): Like the centered overlap option, except that if the image and label 
aspect ratios are different, the image will underlap the label instead of overlapping (cropping) 
it. This means that if the image & label aspect ratios aren't the same, a portion of the label 
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won't be covered by the background image. 
 
3. Stretched: make the selected clip art image your background image, and stretch it to cover 
the entire label. This will make the selected image cover the label exactly, but it could change 
the image's aspect ratio. If the image's aspect ratio is dramatically different from the label's 
aspect ratio, this option could make the image appear stretched or scrunched. 
 
4. Tiled: make the selected clip art image your background image, but instead of stretching it, 
tile it to cover the label.  
 
Add to Label: add a copy of the clip art image to your label's foreground. This has the same 
effect as clicking on a clip art thumbnail and dragging it onto a label. 
 
Show Full Size: pop up a window that displays the selected clip art image at its actual size. 
You can't edit the image or take any other useful actions with this window. It's just there so you 
can take a closer look at it. 
 
Set as Wallpaper: Lets you set the selected clip art image as your Windows desktop 
wallpaper. It has nothing to do with creating labels. It pops up a submenu with these four 
options: 
 
1. Tiled: Sets the clip art image as tiled wallpaper. 
 
2. Centered: Sets the clip art image as centered wallpaper. 
 
3. Stretched: Sets the clip art image as stretched wallpaper. 
 
4. Stretched without Changing Aspect Ratio: Sets the clip art image as stretched wallpaper 
without changing the image's aspect ratio. This means that the image won't get funhouse 
mirrorified if it's not the same aspect ratio as your Windows desktop, but it may leave a blank 
vertical or horizontal band on the desktop. 
 
If you try to set as your Windows wallpaper an image of a type that Windows can't 
automatically set as wallpaper, or it needs to be stretched in some way that Windows can't 
handle automatically, the program will save the image in the correct size and format as a file 
called wallpaper.bmp in your My Documents folder and tell Windows to set this new file as 
your wallpaper. 
 
Remove from list: Removes the selected clip art image from the thumbnails list. It doesn't 
delete or modify the actual clip art image's file in any way. 
 
Rename file: Lets you change the clip art image's file name. This will affect any other 
programs that expect to find the image under its old file name. 
 
Delete file: Deletes the actual clip art image file. Use this option with caution! 
 
 
Stuff You Can Do to a Clip Art Image That You've Added to a Label: 
 
(We're assuming you didn't add your clip art image to a label as the label background. If that's 
what you've done, check out Editing Background Images in the Backgrounds section instead.)
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You can click on it. This will "select" it, so that you can move or resize it. Once you've 
selected a clip art image, you can: 
 
Move it. Do this by left-clicking on the image or its title bar, dragging it to where you want it, 
and releasing the mouse button. 
 
Resize it.  Do this by clicking on one of the red resize squares located around the image's 
border, dragging to whatever size you want, and releasing the mouse button. 
 

  
 
Click on one of its toolbar buttons: When you click on a clip art image and select it, a 
toolbar will appear underneath it. (You can hide or show the toolbar by clicking the little "T" 
button on the image's title bar.) The toolbar has buttons that let you move the image to the 
front or back of all the other objects you've put on your label, or rotate it 90 degrees clockwise 
or counterclockwise. 
 
Right-click it: This will pop up a menu with these options: 
 
Bring to Front: Display the image on top of all other objects you've added to your label. 
 
Send to Back: Display the image behind all other objects you've added to your label except 
the background image. 
 
Rotate/Flip Image: Pops up a submenu with these five options: 
 
1. 90 degrees clockwise: Rotate the image 90 degrees clockwise. 
 
2. 90 degrees counterclockwise: Rotate the image 90 degrees counterclockwise. 
 
3. 180 degrees: Rotate the image 180 degrees. 
 
4. Flip Vertical: Flip the image vertically. 
 
5. Flip Horizontal: Flip the image horizontally (make a mirror image of it).  
 
Edit Image: Pops up a submenu with these four options: 
 
1. Convert to Black & White: Technically, we should describe this as "convert to grayscale." 
 
2. Invert (make a negative): Reverse the color of every pixel in the background image (if this 
doesn't make sense to you, just try it). 
 
3. Make Brighter: Make the image a little bit brighter. 
 
4. Make Darker: Make the image a little bit darker. 
 
Reload: Reloads the image from its original file, discarding any edits you may have done to it.
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Top-left pixel is transparent color: If you've checked this option, Acoustica CD/DVD Label 
Maker will treat the color in the image's top left pixel as the "transparent" color. Any pixels in 
the image with this color will be transparent. Lots of clip art images are designed to be 
displayed with a transparent background; this option lets you do so. Note: this setting usually 
has little effect on JPEG files, because the JPEG compression algorithm will change 
background pixels to colors that are similar to, but not quite the same as, the designated 
transparent color. 
 
Remove: Removes the image from the label. 
 
Cut Image: Removes the image from the label, but puts it on the clipboard, so you can paste it 
back onto the label, or onto any other label, if you wish. 
 
Copy Image: Copies the image to the clipboard without removing it from the label. 
 
Maintain aspect ratio: If you've checked this option, you can resize the image without getting 
the dreaded funhouse mirror effect. If you uncheck it, you can streeeetch or scrunch the image 
as much as you like. 
 
Hide/Show Toolbar: Hides or shows the little image toolbar that normally displays just 
underneath the image whenever you select the image. 
 
Any of these changes that you make to a clip art image will change the way Acoustica 
CD/DVD Label Maker displays the image, but will not affect the clip art image's original file in 
any way. 
 
If you apply any of these changes to an image and decide you don't like them, you can click 
the "Undo" button to retract them. 
 
Help Contents  
 
 
 
Adding Your Own Images to Labels 

 
 
Finding Images to Add to a Label 
 
Acoustica CD/DVD Label Maker provides two ways to find images on your computer that you 
can add to your labels:  
 
1) Click on the "Art Search" tab, enter some text that's in the file or folder names of the art 
you're looking for, and click the "Search" button. Thumbnails of all supported image files 
matching your search terms will appear in the window underneath the search button. We 
support jpg, bmp, png, and pcx graphics types. 
 
2) Click on the "Art Browse" tab, and parse through the explorer tree to see thumbnails of all 
the supported image files in a particular folder. 
 
The "Art Search" and "Art Browse" tabs should be near the top left corner of your program 
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window. They look like this: 
 

  
   
If you're running at a low video resolution or you've resized your tools window to be very 
narrow, the clip art tabs might not be visible: 
 

  
 
In this case, you'll need to click the right arrow to scroll the clip art tabs into view before you 
can select one of them and start adding your own clip art. 
 
 
Using an Image You've Found as a Label Background 
 
Once you've found an image you want to make your background, you can either: 
 
1) Double-left-click on the image's thumbnail to make it the background 
 
or 
 
2) Ctrl + double-click the thumbnail to make it a tiled background 
 
or 
 
3) Right-click on the image's thumbnail and select one of the "Set as background" options. 
 
Note that if the image you've selected doesn't have the same aspect ratio as the label you're 
putting it on, it may appear stretched or squished. It that's the case, you can drag the image's 
thumbnail and drop it onto the label, then click on the sizing bars to make it big enough to 
overlap the label without altering its aspect ratio, and click on its title bar or the image itself to 
position it where you want it. 
 
 
Adding an Image You've Found as Clip Art 
 
Once you've found an image you want to add to your label, just left-click on its thumbnail, drag 
it onto your label, and release the mouse button. The program will place the image where you 
dropped it. As soon as you drop it, it should be in "selected" mode, with sizing bars and a 
toolbar. You can click on the image's sizing bars to resize the image; you can click on the 
image's title bar or the image itself to move it. You can also right-click on the image to pop up a 
menu with a variety of editing options. 
 
You can also drag image files from Windows Explorer and drop them onto your label. 
 
For more details on using your own images, see the Clip Art topic. 
 
Help Contents  
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Backgrounds 

 
 
Click on the Backgrounds tab along the top-left side of Acoustica CD/DVD Label Maker's main 
window, and you'll see thumbnails of all the pre-built background images that we ship with the 
program. Click on any one of the thumbnails, and it will become your label's background 
image. 
 
If you want to edit your background image or, heaven forbid, remove it altogether, you'll need 
to escort your mouse over to the label window and right-click on the background image, which 
will popup a menu with various options for taking care of your background-editing needs. If 
you're not a right-clicker, you can, alternatively, select the Background option on the main 
menu. 
 
Editing Background Images 
 
Selecting the Edit Background Image option from the Background menu will bring up a list of 
things you can do to your background image. Here's the lot: 
 
90 degrees clockwise: Rotate the background image 90 degrees clockwise. 
 
90 degrees counterclockwise: Rotate the background image 90 degrees counterclockwise. 
 
180 degrees: Rotate the background 180 degrees. 
 
Flip vertical: Flip the image vertically. 
 
Flip horizontal: Flip the image horizontally (make a mirror image of it).  
 
Convert to black and white: Technically, we should describe this as "convert to grayscale."  
 
Invert (make a negative): Reverse the color of every pixel in the background image (if this 
doesn't make sense to you, just try it). 
 
Make brighter: Make the background image a little bit brighter. 
 
Make darker: Make the background image a little bit darker. 
 
Reload: Reload the background image in its original form, discarding any of the editing options 
in the above list that you may have performed. 
 
Of course, if you try any of these edits and you don't like them, you can always click on the 
"Undo" button to get rid of them. 
 
 
More Backgrounds 
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We've got lots more background art than we could fit into our download file. Open the Help 
menu and click on the Check for new art option, and we'll launch your browser with the URL of 
our extra-art page.  
 
Help Contents  
 
 
 
Art Browse 

 
 
If you want to use the traditional Windows-Explorer style interface for finding clip art on your 
computer, click on the Art Browse tab near the top of the program's main window. This will 
bring up our explorer-tree clip art window. Instead of a list of file names, though, our browse 
tab displays thumbnails of all the images in whatever folder is currently selected. Call us crazy, 
but we think it's easier to find the pictures you want by looking at the actual pictures than by 
deciphering their file names. 
 
The Art Browse tab pane contains two windows. The top window is a Windows Explorer tree. 
Use it to find the folders where your clip art resides. Click on the + sign beside a folder or drive 
you want to dive into, and the tree will expand to show the subdirectories that the folder or 
drive contains. Click on the name of a folder or drive, and the Art Browse pane's lower window 
will fill with the images that are in that folder (not including the images in any subdirectories it 
may have), should it have any. 
 
Changing the Explorer Tree & Thumbnail Window Sizes 
 
You can change the amount of space devoted to the explorer tree window vs. the thumbnails 
window by clicking on the border between them and dragging it up or down. The mouse cursor 
will change into a little vertical resizing arrow when it's over the resizing border. 
 
About the Clip Art Cache 
 
Acoustica CD/DVD Label Maker caches the thumbnails of any clip art images it finds. Or, 
translated into English: the first time the program displays the thumbnail of a clip art image, it 
will take longer to display than it will any time from then on. That's because the first time 
through, it has to create the thumbnail that gets displayed. But it saves the thumbnail in a 
special cache, so anytime the program displays that thumbnail from then on, it can retrieve the 
thumbnail from the cache instead of creating it, so it will be much faster. 
 
Note: the program bases the thumbnail size on your current video resolution, so that 
thumbnails will occupy roughly the same amount of your available screen space no matter 
what resolution you're running in. If you change your screen's resolution (such as from 800 by 
600 to 1,024 by 768), the absolute thumbnail sizes will change, so the program will have to 
create new thumbnails for any clip art that it displays. 
 
Help Contents  
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Art Search 

 
 
If you want Acoustica CD/DVD Label Maker to search for clip art images on your computer's 
hard drive(s), click on the Art Search tab near the top of the program's main window. Then 
follow these steps: 
 
1) Type something to search for into the "Search for:" field. The search will find any file names 
containing the text string you've entered here. If a directory name contains the string you've 
typed in, the search will find any images in that directory and its subdirectories. If you leave the 
"Search for:" field blank, the search will find all images in all directories. 
 
2) Choose the image types that you want to search through, in the "File types:" combo box. If 
you select "All", the search will find any image types that the program supports. Currently this 
includes file extension types .bmp, .dib, .jpg, .jpeg, .png, .pcx, .wmf, .gif, and .tif, plus various 
flavors of Raw images. 
 
3) Click the "Search" button. The button will change into a "Stop" button. Clicking on it again 
will stop the search. Once the search has finished, it will revert back to a "Search" button. 
 
Any images that the search finds will show up in the thumbnails list. The search will only find 
files on your computer's fixed drives  -- it will skip floppy drives, CD-ROM drives, Zip drives, 
etc. If you need to search on a removable drive, you'll have to click on the Clip Art Browse 
tabClip_Art_Explore and use our explorer control to find the clip art you're looking for. 
 
Help Contents  
 
 
 
Colored Shapes 

 
 
In case clip art, background images, and text objects aren't enough to satisfy your creative 
needs, Acoustica CD/DVD Label Maker offers a small assortment of colored shapes that you 
can plaster all over your labels. Click on the "Shapes" button on the main toolbar, and a dialog 
will pop up that will let you add them to your label. You can move and resize these shapes just 
like any other objects: move them by clicking on their title bars or the shapes themselves and 
then dragging them; resize them by clicking on and dragging any of the little red resize bars 
scattered around the shape's borders. (These borders, I should add, are only visible when the 
shape is in a "selected" state, meaning that you've clicked on it and haven't clicked on anything 
else in the meantime.) 
 
Once you click on a shape that you've added to a label, you should see a little shape-editing 
toolbar appear beneath it. If there's no toolbar, click on the little "T" button in the shape's 
titlebar. These buttons, taken from left to right, let you: 
 
* change its shape 
* change the shape's background color 
* move the shape in front of all other objects on the label

Page 16 of 85

6/13/2006file://C:\acoustica\cdlabelmaker\help\cd-label-maker-flat.htm



* move the shape behind everything else on the label (except the background image, if any) 
 

  
 
One of our favorite ways to waste time with shape objects is to drag them around the screen a 
little bit at a time, as if we were creating slow motion pong games or sunsets, and then play 
them back like movies by holding down the Ctrl-Z (undo) key until everything comes to a stop, 
then playing them back in the other direction by holding down the Ctrl-Y (redo) key. This 
accomplishes absolutely nothing, and will not help you create CD labels. But you might enjoy 
that sort of thing. 
 
Help Contents  
 
 
 
Layouts 

 
 
The layouts feature is a way to take advantage of other people's creativity. We're not always in 
the mood to lay out each of our labels, and decide where we want to put the tracks listing, and 
how to arrange it, and whether we want a title on the label, or a dedication, or any number of 
other things. We want the program to do it for us. So we added layouts to the program. If you 
click on the Layouts tab (near the top left of Acoustica CD/DVD Label Maker's main window), 
you'll see thumbnails of pre-built layouts you can try. Just click on one, and Acoustica will 
rearrange your label to match the layout you've selected. A layout can include text fields 
(including tracks arrangements), colored shapes, and/or images. If you don't like a layout 
you've selected, you can either click on another layout, click the "Undo" button, or click on the 
"roll your own" layout, which will remove all layout-specific elements from your current label. 
 
Creating Your Own Layouts 
 
Creative genius that you are, you probably won't have played with Acoustica CD/DVD Label 
Maker for very long before you wind up inventing a label design of such majesty that you want 
to save it to reuse on future labels. When this happens, open the File menu, click on 
Advanced, and select the Save Current Label as Layout option. You can't miss it; it's currently 
the only entry on the File | Advanced menu.  
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Selecting this option will bring up a dialog that lets you save the current label as a layout. You 
can save whichever elements you like: text fields, colored shapes, and/or images. You can 
also specify which label types you want to be able to use this new layout with. Once you've 
typed in a name for your new layout and clicked the OK button, your new layout will show up 
under the Layouts tab along with all the pre-built layouts that we supplied with the program. 
We hope your marvelous new layout won't mind slumming it with all our comparatively 
pedestrian pre-supplied ones.  
 
Help Contents  
 
 
 
Printing 

 
 
When you're ready to print your label, click the Print button on the main toolbar or select the 
Print item from the File menu. This will launch the Print dialog, unless you're in trial mode and 
you've used up your free trial. If that's the case, register Registrationand then come back. 
 
The Print dialog consists of printer-specific information, at the top of the dialog, and label-
specific information, at the bottom of the dialog.  
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The "Printer" Section: 
 
Name: Gives you a list of all the printers attached to your computer. Choose the one you want 
to use. 
 
Paper Bin: Lets you choose which bin you want the printer to grab paper from, should your 
chosen printer have multiple paper bins. 
 
Print to File: If checked, printing won't go to the printer; instead, it will go to a file in a format 
that your chosen printer can recognize, so that you can, in theory, print it later - although you 
could always just run Acoustica CD/DVD Label Maker again, instead. 
 
Copies: Lets you choose how many copies of each label you want to print. 
 
Properties: Launches a dialog that lets you set options - print quality, for instance -- specific to 
the printer you've chosen. Since your printer manufacturer supplies this dialog, we can't predict 
precisely what will be on it or give you detailed help with it. 
 
Alignment: Launches the Printer Alignment Dialog,The_Printer_Alignment_Dialog which lets 
you set printer offsets and label stretch amounts in case your printer, like most printers, doesn't 
print at precisely the locations it's supposed to. 
 
 
The Labels Section: 
 
the row of tabs: Clicking on these lets you bring up a tab for choosing paper type and sundry 
other options for particular labels and  case inserts. If you've chosen to print a label, it will have 
a little printer icon in its tab. 
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Paper Type: Lets you choose the type of paper you want to print on. Whenever you choose a 
different paper type from this list, the thumbnail underneath the Click on labels to use heading 
will display the layout of the paper you've chosen. 
 
Print a border around label: If you check this box, the program will print a thin black border 
around the label. This can be handy if you're printing on plain paper and your background has 
lots of white in it. 
 
Print fold lines: If you check this box, Acoustica CD/DVD Label Maker will print fold lines to 
help you fold your labels. You don't need to check this box unless you're printing on plain 
paper; most stock paper forms have folds built into the paper. If you check this box for the 
jewel case back, the label maker will print lines indicating where to fold the two spines. If you 
check this box for the jewel case front/inside, the label maker will print a line indicating where 
to fold the front/inside booklet in half. (The box will be disabled for the front/inside label if 
you're not printing on a paper type that prints both the front and inside labels on the same side 
of the paper.) This checkbox will always be disabled for CD and DVD labels, or for any other 
labels that don't have fold lines. 
 
You can set a variety of options for fold lines in 
thePreferences_Dialog_Printing_Fold_Lines_Page Preferences Dialog. You can decide 
whether you want your fold lines to be solid or dashed lines, whether you want them to be 
inside or outside the label, and what color you want them to be. 
 
Crop Label Holes: If you check this box, Acoustica CD/DVD Label Maker won't print in the 
hole areas of your CDs. This can save ink, but also runs the risk of showing white bands on 
your label if your printer alignment is significantly off. However, if you've got non-zero label 
stretch settings (the software defaults to 2.0 millimeters) to stretch your label diameter to help 
compensate for alignment issues, your hole will also get stretched -- or rather, unstretched. If 
your label hole is 41 millimeters in diameter, your stretch setting is 2.0 millimeters, and you've 
got Crop Label Holes checked, your printed label will have a 39-millimeter diameter hole. 
 
If you're printing to a printable disc, Crop Label Holes will be automatically disabled and 
checked -- for printable discs, you have to crop out the hole, or you'll end up with ink all over 
the non-printable hole area of your disc. For the same reason, stretch settings are ignored for 
printable discs. 
 
If you're printing a label that doesn't have a hole -- a CD jewel case insert, for instance -- the 
Crop Label Holes checkbox won't be visible. 
 
Click on labels to use: If you've chosen a paper type that can print more than one label of the 
type you're printing, you can click on the the labels on the thumbnail to choose which of the 
paper's labels you want to print on. 
 
Sheets required:  Tells you how many sheets you'll need of the paper you've selected, based 
on how many copies you're printing and how many of your selected paper type's labels you've 
chosen to use. 
 
That arrow pointing to the left: Indicates which edge of the paper displayed in the thumbnail 
image you should feed into the printer first. 
 
Print Disc / Print Front/Inside / Print Back: These checkboxes let you choose which labels 
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you want to print. If you check the box for a label, it will print. If not, it won't. 
 
Once you've selected what you want to print and what you want to print it on, click the Print 
button to proceed. The next thing you see will be: 
 
 
The Insert-Paper Dialog: 
 

  
 
This dialog will prompt you to insert one or more sheets of the paper types you've chosen for 
the labels you've chosen to print. The buttons on the dialog will behave as follows: 
 
Print: print the label(s) 
Cancel: cancel the entire printing operation. 
Skip: don't print this label; if you've selected more than one label to print, the dialog will 
advance to the next label. 
Help: launch this help page. 
 
If you're printing more than one of your labels, the dialog will appear multiple times. If you're 
printing, say, a CD disc and a jewel case back, the dialog will appear twice, once to prompt 
you to insert your CD disc label paper, and again to tell you to insert the jewel case back 
paper. 
 
If you're printing the jewel case front/inside on a paper type that has a single face instead of a 
book arrangement, you'll get prompted to insert the paper for it, and then you'll be asked to 
reinsert the paper upside-down so the program can print the jewel case inside on the back of 
the paper. Make sure the fronts have finished printing and you've reinserted the labels before 
you click the "Print" button on the "reinsert upside-down" dialog. 
 
Printing for the First Time: 
 
If you're printing with a new type of label stock for the first time, we recommend that you feed 
plain paper into the printer instead, even though the insert-paper dialog has told you to insert 
sheets of your label stock. This way you can check your printer's alignment before using up 
any of your relatively expensive label stock. Once it's printed on plain paper, you should be 
able to see if it's aligned correctly by putting a sheet of your label stock on top of your freshly 
printed sheet of plain paper, making sure they line up exactly on top of each other, and then 
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holding the two sheets in front of a light so that the printed label on the plain paper underneath 
is visible. This should help prevent you from wasting custom paper stock tracking down your 
printer's alignment problems.  
 
If you haven't run the Printer Calibration Wizard yet, try it as well. It prints an alignment test 
sheet that can help you determine whether or not your printer has enough calibration error to 
require alignment adjustments. You can launch the Printer Calibration Wizard from the File 
menu. 
 
For more information on setting your printer's alignment, see theThe_Printer_Alignment_Dialog 
Printer Alignment dialog. 
 
Help Contents  
 
 
 
The Printer Alignment Dialog 

 
 

  
 
Printers are imprecise beasts. You can tell them to print something exactly 1.2 inches from the 
top of the paper, but chances are, it'll end up being more like 1.1 or 1.28 inches from the top. 
The older your printer gets, the more likely this is to occur, as all the little mechanical bits that 
escort paper into and out of the printer get worn out. You're not likely to notice this flaw when 
you're printing, say, a resumé. And if your interviewer is measuring the margins on your 
resumé, you may be happier elsewhere anyway. But when you're printing CD labels on a pre-
cut form, every millimeter matters. (That's why millimeters would rather be on a CD label than 
a plain sheet of paper - they like to feel important.) If your printer is a millimeter awry on a CD 
label, you'll get a millimeter of white, unprinted space on your label. It won't look good. 
 
If your printer is consistently wrong, which is often the case, you can use the Printer Offsets 
section of this dialog to correct it. If the printer always prints a millimeter to the right of where 
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it's supposed to, you can use this section to tell the program to always print labels one 
millimeter to the left of where they'd normally go, which will cancel out the printer's imprecision 
and make things print just where they ought to be. 
 
Before you make any adjustments via this dialog, we'd like to make two important 
recommendations: 
 
Recommendation #1: Run the Printer Calibration Wizard first!  This wizard will print a 
calibration test sheet to help you determine what settings you need in this dialog -- and in fact, 
you can enter them there instead, and you may never actually have to launch this dialog at all. 
You can get to the Printer Calibration Wizard from the "File" menu. 
 
Recommendation #2: If you've launched this dialog to fix the alignment for printing 
printable discs, stop! Go to the Edit Paper/Printer Templates dialog instead. The alignment 
error a printer has for printing paper from a paper tray and for printing on a CD that's fed into 
the printer via a CD tray is almost never the same, so applying the same alignment 
adjustments to both is likely to cause problems. 
 
You can set alignment settings exclusively for your CD tray at the Edit Paper/Printer Templates
dialog, and, thanks to the "Don't apply to printable discs" checkbox on this dialog, you can 
make alignment settings exclusively for paper on this dialog, and they'll never interfere with 
each other. You can also, of course, make alignment adjustments for particular paper types 
from the Edit Paper/Printer Templates dialog (keep in mind that changes made there will apply 
to any printer you print that paper in, whereas changes in this dialog only apply to a particular 
printer.) You can launch the Edit Paper/Printer Templates dialog from the "File" menu. 
 
 
"Printer Offsets" controls: 
 
Move labels by: There's one of these sections each for horizontal and vertical paper 
alignment. Enter the amount of space, in millimeters, by which you need to move labels 
horizontally and vertically, respectively, for the printer you've chosen. 
 
To the left/To the right: Lets you select the direction in which to correct your printer's 
horizontal printing errors. If your printer always prints stuff too far to the right, check the "To the 
left" box. If it always prints too far to the left, check the "To the right" box. 
 
Up/Down: Lets you select the direction in which to correct your printer's vertical printing errors. 
If your printer always prints stuff too far down the page, check the "Up" box. If if prints too high, 
check the "Down" box. 
 
Don't apply to printable discs: If this box is checked, the printer-alignment settings you make 
here will be ignored when you're printing on printable discs. We recommend checking this 
option. The printer alignment error that occurs when printing on paper from a paper tray is 
highly unlikely to be identical to any printer alignment error that occurs when you're printing on 
a CD tray inserted into the printer, so using the same settings for both is likely to create as 
many problems as it solves. We recommend using the alignment settings on this dialog to 
account for paper-related alignment errors, and using the Edit Paper/Printer Templates dialog 
(which you can launch from the File menu) to account for any printable-disc alignment error. 
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The "Stretch Labels" section: 
 
If your printer doesn't align correctly, but isn't consistent about it, you can correct it by using the 
brute force method of stretching all the labels by a millimeter or two, which will result in the 
label being slightly larger in every direction. So even if your printer prints too high one pass, 
and too low the next, or likes to feint left and print right, you'll be set. 
 
We generally recommend setting the stretch labels amount at one to two millimeters. We also 
recommend that you don't put important stuff, such as text, within a millimeter or so of your 
label borders or the CD hole unless you have a fabulously reliable printer, because otherwise it 
stands a good chance of getting chopped off when you print it. 
 
But don't stretch plain-paper labels: This checkbox lets you specify whether or not you want 
to apply your stretch settings to labels you print on plain paper. By default, this box will be 
checked, which is our recommendation. The stretch labels settings are designed to overcome 
problems with your printer's alignment so that you can fit labels onto premade forms. But since 
plain paper doesn't have any pre-perforated labels that you need to line your labels up with, 
stretching isn't necessary, and in fact will only make your labels bigger than they need to be.  
 
 
Printing 
 
Help Contents  
 
 
 
The Insert-Paper Dialog 

 
 

  
 
This dialog will prompt you to insert one or more sheets of the paper types you've chosen for 
the labels you've chosen to print. The buttons on the dialog will behave as follows: 
 
Print: print the label(s) 
Cancel: cancel the entire printing operation. 
Skip: don't print this label; if you've selected more than one label to print, the dialog will 
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advance to the next label. 
Help: launch this help page. 
 
If you're printing more than one of your labels, the dialog will appear multiple times. If you're 
printing, say, a CD label and a CD jewel case back insert, the dialog will appear twice, once to 
prompt you to insert your CD label paper, and again to tell you to insert the jewel case back 
paper. 
 
If you're printing the jewel case front/inside on a paper type that has a single face instead of a 
book arrangement, you'll get prompted to insert the paper for it, and then you'll be asked to 
reinsert the paper upside-down so that Acoustica CD/DVD Label Maker can print the jewel 
case inside on the back of the paper. Make sure the fronts have finished printing and you've 
reinserted the labels before you click the "Print" button on the "reinsert upside-down" dialog. 
 
Printing for the First Time: 
 
If you're printing with a new type of label stock for the first time, we recommend that you feed 
plain paper into the printer instead, even though the insert-paper dialog has told you to insert 
sheets of your label stock. This way you can check your printer's alignment before using up 
any of your relatively expensive label stock. Once it's printed on plain paper, you should be 
able to see if it's aligned correctly by putting a sheet of your label stock on top of your freshly 
printed sheet of plain paper, making sure they line up exactly on top of each other, and then 
holding the two sheets in front of a light so that the printed label on the plain paper underneath 
is visible. This should help prevent you from wasting custom paper stock tracking down your 
printer's alignment problems. For more information on setting your printer's alignment, see the 
Printer Alignment dialog. 
 
 
Printing 
 
Help Contents  
 
 
 
The "Edit Paper/Printer Templates" Dialog 

 
 

 
 
This dialog allows you to edit the 
sizes and positions of individual 
labels on sheets of label paper 
(or on the templates for direct-to-
CD printers). There are a couple 
common circumstances when you 
might want to do this: 
 
* when you're printing directly 
onto a printable CD or DVD and 
your discs don't have a standard 
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printable diameter or hole 
diameter (118 millimeters and 41 millimeters, respectively, for CDs and DVDs), you can use 
this dialog to set the diameters to match the printable discs you're using. 
 
* when your printer doesn't feed a particular label efficiently, and as a result, the farther down 
or across the page you go, the less well aligned your labels are. Label sheets that are folded in 
half to fit in the box you buy them in are particularly prone to this problem. When this occurs, 
you can use this dialog to resize or reposition the particular labels that don't line up correctly in 
your printer. 
 
Why would I use this dialog instead of the Alignment dialog (the one you can launch 
from the Print dialog or the Preferences dialog)? 
 
The regular Alignment dialog makes changes that only apply to a particular printer, but to all 
labels on all paper types (except plain paper and printable CDs) that you print with that printer. 
So it works best if your printer has an alignment problem that always manifests itself in the 
same way no matter what kind of paper you're using. This dialog, on the other hand, lets you 
make changes that apply to all the printers you've got, but only to particular labels on particular 
paper types. It's best for changing the diameters of printable CDs and DVDs to match the 
media you're using, and for quirky alignment problems that only occur with particular types of 
paper. 
 
 
The Top Half of the "Edit Paper Templates" Dialog: 
 
The top half of the "Edit Paper Templates" dialog contains controls for choosing the label you 
want to edit.The listbox under the "Template Name:" heading lists all the paper types & direct-
to-CD printer templates installed in the software. Scroll through and click on the paper type you 
want to edit, and a thumbnail of the paper's layout will appear on the right side of the dialog. 
The currently selected label on your selected paper type will be highlighted in green on this 
thumbnail; to edit a different label, just click on its image in the thumbnail.  
 
The "Front of Sheet" checkbox will usually be disabled. However, if you're editing a paper type 
that has different labels on the front and back of the sheet, this box will be enabled and you 
can click on it to toggle between views of the front and back of your selected label paper. If 
you've got a label such as a jewel case insert that prints on both the front and back of the 
sheet, you won't be able to select it on the back-of-the-sheet view; if you need to edit it, you'll 
have to edit it from the front-of-sheet view.  
 
 
The Bottom Half of the "Edit Paper Templates" Dialog: 
 
The "Adjustments for Selected Label" section is where you can change the size and 
position of the label you've selected. Here's a summary of the controls on this part of the 
dialog: 
 
Move by (left/right): This allows you to move a label to the left or right on the page -- or more 
accurately, to make the label maker behave as if the label has moved. Units are in millimeters. 
The label's position on the thumbnail in the top half of the dialog will update as you change the 
amounts, so if you're confused about what left and right mean in this context, just play with the 
control, and you'll soon see. 
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Move by (up/down): This allows you to move a label up or down on the page. Units, again, 
are in millimeters. 
 
Diameter (mm): This allows you to edit a CD, DVD, or mini-CD's diameter, in millimeters. The 
label maker will automatically center your size changes against the original center of the CD. 
Which might sound a bit confusing, but just means that if you change your disc diameter from, 
say, 118 millimeters to 110 millimeters to fit the type of printable CD you've got, you don't need 
to also change the left/right and up/down settings to keep your resized disc from getting printed 
off center. It's taken care of already. If this still isn't clear, just try playing with the diameter 
setting, and you'll notice that the label's thumbnail in the top half of the dialog stays centered in 
the same spot. 
 
Hole Diameter (mm): This allows you to edit the center-hole diameter of a CD, DVD, or mini-
CD. The label maker will automatically center the hole on the disc, no matter what disc or hole 
diameters you've set. 
 
Width (mm): Allows you to change the width of a label (for non-CD/DVD labels only; for discs, 
you adjust the diameter instead). Units are in millimeters. 
 
Height (mm): Allows you to change the height of a label (for non-CD/DVD labels only; for 
discs, you adjust the diameter instead). Units are in millimeters. 
 
Reset: If you mess up your settings so badly that you just want to start over, click the Reset 
button and the current label will get reset to its original, unaltered settings. Not that you would 
ever need this. This is strictly for our other, less gifted users. 
 
 
Print a Ruler: If your desk resembles ours, you might have a ruler on it someplace, but who 
would ever know? There could be a Yeti under that mountain of stuff, happily using the ruler 
for a backscratcher, and it wouldn't surprise you. For people like you (and us), we present the 
Print a Ruler button. Click it to print a brand new ruler that you can use for all the fine-grained 
calculations that this dialog allows. 
 
OK: Happy with the changes you've made in this dialog? Want to keep them? Then click the 
OK button. 
 
Cancel: Having second thoughts? Did you open this dialog and do things that you're afraid 
could alter the nature of space & time and unleash gophers from another dimension onto our 
unsuspecting planet? Just click the Cancel button, and it'll all go away like a bad dream. 
 
Help: Something tells us you've already figured out what this button does. 
 
 
When you save changes you've made in this dialog, the label maker saves them in text files 
under your "My Documents" folder. In particular, your "My Documents" folder should have an 
"Acoustica" subfolder, and the "Acoustica" subfolder should have a "paper align" subfolder. 
Here you'll find your adjustments, saved in text files with a .paj extension and a file name 
matching the paper type you were editing. If you're running the label maker on multiple 
computers and you want to copy your alignment adjustments from this dialog to another 
computer, just copy these files and place them in the same folder on the other computer.
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Help Contents 
 
 
 
 
Printing Troubleshooting 

 
 
Printable Disc Issues 
 
When I try to print a printable disc on my Canon printer, I get an error message that the tray 
door is open. 
 
I've got a Canon printer, but the CD tray doesn't show up among the paper-bin options. 
 
When I print printable CDs or DVDs on my Epson printer, the discs come out with banding or 
other quality problems, yet they look fine when printing with the software that came with the 
printer. 
 
When I print directly to CD, the ink doesn't stick - it bubbles up and wipes off easily. 
 
 
Paper & Miscellaneous Issues 
 
How do I get my printer aligned without using up lots of valuable label paper? 
 
How do I choose the paper type I want to print on? 
 
When I print labels, they don't line up exactly where they're supposed to. 
 
My alignment's all over the place from one printout to the next. 
 
The software doesn't support the make or brand of label paper I own. 
 
Some of my labels print without graphics or other elements of my design. 
 
When I print my labels, they're way too small or way too large, or parts of them are chopped 
off. 
 
How can I print borders around my labels or print fold lines for them? 
 
How do I print more than one copy of a label at a time? 
 
The software tells me my paper is too small and part of my label will get chopped off. 
 
The software always prints the top label on my label sheet. How do I tell it to print on the 
bottom label? 
 
How do I print all 3 labels on a 3-up CD label sheet?
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Why do some of the paper names say "US" and some say "A4"? And why do some say 
"Legal"? Can I get arrested for printing on contraband paper? 
 
All my labels get printed in black & white, even though I've got a color printer. 
 
When I print, the print quality is poor or I get odd colors. 
 
When I try to print, I get a message that the printer is offline or unavailable. 
 
 
How do I get my printer aligned without using up lots of valuable label paper? 
 
Start by running the Printer Calibration Wizard, which you can access from the "File" menu. It 
prints a calibration test sheet that helps you determine how much alignment adjustment your 
printer needs. 
 
Another trick we like to use is to set the paper type to your normal label paper, but then insert a 
sheet of plain paper in the printer instead when you print. Once your label has printed on plain 
paper, paper-clip it to a sheet of your label paper (put the printed plain sheet behind the label 
sheet) and hold it up to a light. The label printed on plain paper will usually be visible behind 
the sheet of label paper, so you can see how closely the printed label matches up to the 
outlines of the labels on your label sheet. Make sure you've matched up the edges of the two 
sheets evenly when you do this, of course. 
 
If you determine that you need to adjust your printer's alignment, do so from the Alignment 
dialog, which you can launch by clicking the "Alignment" button on the Print dialog. 
 
 
How do I choose the paper type I want to print on? 
 
At the bottom of the label window (the area in Acoustica CD/DVD Label Maker where you 
design your label), you'll find a combo box that lists all the available paper types and printable-
disc printers. Choose your paper type from the list that pops up when you click the down-arrow 
button on the combo box. You can change your paper or printer choice at any time; once 
you've designed a label, you're not locked into using the paper type you chose at the start of 
the project.  
 
You can also change your paper type from the Print dialog. Please note that when you change 
your paper type via the combo box at the bottom of the label window, the label maker will 
automatically update the layout to reflect any changes (such as bigger or smaller label holes) 
and reformat text objects if necessary. This automatic reformatting won't take place when you 
select a new paper type from the Print dialog, though, until after you've exited the dialog. 
 
 
When I print labels, they don't line up exactly where they're supposed to. 
 
* Make sure your paper fits snugly in your printer's paper tray. If it has room to slide around, it's 
likely to line up incorrectly when it goes through the printer.  
 
* Make sure you've selected the correct paper type. Some companies (Neato, for instance), 
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make a large variety of papers for different kinds of labels and in both letter and A4 sizes, and 
if you've inadvertently selected the wrong model, the labels won't line up correctly when they 
print. 
 
* Run the Printer Calibration Wizard (accessible from the "File" menu), which can help you 
determine whether or not you need to make adjustments to account for your printer's 
alignment error. 
 
* Check to see whether you've selected any printer settings that will affect your printed label 
sizes or positions. To do this, click the "Properties" button on the Print dialog. The printer-
properties dialog that pops up was designed by your printer manufacturer and will differ 
depending on what kind of printer you have, so we can't tell you exactly what to look for. But if 
you have settings such as "shrink to fit page", disable them, and if you have scale settings, 
make sure they're at 100%. If you've got a setting for fitting multiple pages of output onto a 
single sheet, make sure it's set to the normal setting, which will usually be 1 page per sheet. 
 
 
My alignment's all over the place from one printout to the next. 
 
Make sure your paper fits snugly in your printer's paper tray. If it has room to slide around, it's 
likely to feed through the printer inconsistently from one print job to the next. 
 
If that's not the culprit, it could be that your printer just doesn't align consistently. Try running 
the Printer Calibration Wizard and printing multiple copies of the alignment test sheet to see if 
your printer's alignment error is inconsistent. If so, your best bet is to use the "stretch" settings 
in the Printer Alignment dialog (accessible by clicking the "Alignment" button on the Print 
dialog) to make your printouts larger than normal to try and compensate for the alignment 
error. 
 
 
The software doesn't support the make or brand of label paper I own. 
 
We make every effort to support all the brands of label paper that our customers use. If you've 
got one we don't support, there's a good chance we just haven't heard of it yet or we can't 
track down samples of it where we're located. If you send us a sheet or two, we can usually 
create a template for it. 
 
 
Some of my labels print without graphics or other elements of my design. 
 
This is often a sign of a shortage of memory or hard drive space. Inkjet printers use your 
computer's memory and hard drive space to compose pages before they print them. If there's 
a shortage of either, it could cause your printer to behave in peculiar ways. Try closing 
unnecessary applications and freeing up hard drive space if you've got unnecessary files 
hanging about. If you've got a laser printer, which composes each page in its internal memory 
before printing, the printer itself may need extra memory. 
 
If you try reducing the print quality (by clicking the "Properties" button on the Print dialog) and 
the problem goes away, the culprit is almost certainly a shortage of memory (either on your 
computer or laser printer) or disk space. 
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When I print my labels, they're way too small or way too large, or parts of them are 
chopped off. 
 
Huge discrepancies in label size are usually due to printer-properties issues. Check to see 
whether you've selected any printer settings that will affect your printed label sizes or positions. 
To do this, click the "Properties" button on the Print dialog. The printer-properties dialog that 
pops up was designed by your printer manufacturer and will differ depending on what kind of 
printer you have, so we can't tell you exactly what to look for. But if you have settings such as 
"shrink to fit page", disable them, and if you have scale settings, make sure they're at 100%. 
 
If parts of your labels are chopped off, it's often a result of a shortage of memory or hard drive 
space. See the previous question for more details. If parts of your label near the edge of the 
sheet are chopped off, they could be overlapping your printer's unprintable margins. You'll 
usually receive a warning message if this is the case. 
 
 
How can I print borders around my labels or print fold lines for them? 
 
On the Print dialog, check the box labeled "Print a border around label" to print a border 
around your label, and check the box labeled "Print fold lines" to print fold lines. This box will 
be disabled for labels that don't actually have any foldable bits. 
 
You can adjust the appearance of your fold lines from the "Printing fold lines" page of the 
"Preferences" dialog (accessible from the "File" menu), including line color, whether to print 
solid or dashed lines, and whether to print the lines inside or outside the label. 
 
 
How do I print more than one copy of a label at a time? 
 
Set the number of copies you want to print in the "Copies" control near the top of the Print 
dialog. 
 
 
The software tells me my paper is too small and part of my label will get chopped off. 
 
Many printers have unprintable margins -- they can't print all the way to the edge of a sheet. If 
your label overlaps your printer's unprintable areas, this warning message will appear. If you're 
printing on plain paper, switching to a larger paper size, such as a legal sheet, will usually fix 
this. If your printer is really capable of edge-to-edge printing, you may need to adjust printer 
settings to tell the printer to actually print edge to edge; usually you can do this from your 
printer properties dialog or by choosing the appropriate paper bin setting. 
 
 
The software always prints the top label on my label sheet. How do I tell it to print on the 
bottom label? 
 
On the Print dialog, you'll see a thumbnail representing your label paper. The label that's 
currently selected to be printed will be displayed on the sheet. If you want to print on a different 
label on the sheet, just click on it, and it will get selected instead. Note that the arrow beside 
the thumbnail represents the direction in which you'll feed the paper into the printer, so the 
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edge of the paper thumbnail next to the arrow will usually be the top of the sheet. 
 
 
How do I print all 3 labels on a 3-up CD label sheet? 
 
You'll have to send the paper through the printer twice. Because the bounding rectangle of the 
center label overlaps the bounding rectangles of the top and bottom labels on all the 3-up 
sheets we've seen,  it can't be printed at the same time as the top or bottom labels, or they'll 
have sections of them whited out. 
 
 
Why do some of the paper names say "US" and some say "A4"? And why do some say 
"Legal"? Can I get arrested for printing on contraband paper? 
 
These names represent paper sizes. "US" paper is standard letter paper, 8.5 x 11 inches; 
"Legal" paper is 8.5 x 14 inches, and "A4" paper is 210 x 297 millimeters. We promise not to 
tell anyone if you're not printing on Legal paper. 
 
 
All my labels get printed in black & white, even though I've got a color printer. 
 
It's possible that your color ink cartridge is empty. More likely, though, is that you've got a "print 
in black & white" setting somewhere in your printer properties dialog, and somehow, someway, 
it's gotten set. Click the "Properties" button on the Print dialog to launch your printer's 
properties dialog so you can hunt this down and fix it. 
 
 
When I print, the print quality is poor or I get odd colors. 
 
Make sure that your printer doesn't have any empty ink cartridges. If color documents printed 
with other software exhibit the same problem, an empty ink cartridge is probably the culprit. 
 
If not, click the "Properties" button on the Print dialog to launch your printer's properties dialog 
and check to see if you've checked any settings that will negatively affect print quality -- the 
print quality setting itself would be a good starting point, although your printer may also have 
settings to use custom color subsitutions or other schemes that could hurt print quality. If 
you've got other software that prints correctly, try launching the printer properties dialog in 
those apps and comparing them to see what settings are different. 
 
When I try to print, I get a message that the printer is offline or unavailable. 
 
This means that your printer is not correctly hooked to your computer or is in a state in which it 
can't print. Check these items: 
 
* Have you selected the right printer in the label maker's Print dialog? It may sound obvious, 
but it's worth checking to be sure. 
 
* If you've selected the right printer, is the power on and is it hooked up to your computer? Is 
there a paper jam, paper outage, or other condition that would cause it to refuse to print? (If 
the printer is in an unhappy state, there's often an error light blinking on it somewhere.) Check 
that the cable attaching the printer to your computer is securely attached, and try turning the 
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printer off and on again.  
 
 
Printable CD/DVD Issues 
 
When I try to print a printable disc on my Canon printer, I get an error message that the 
tray door is open. 
 
The label maker attempts to automatically set the paper bin and media type on your Canon 
printer to prevent this error from occurring. However, there may be something unusual about 
your Canon model that prevents this from working. If that's the case, here's how to handle the 
error manually: 
 
1) Bring up the File menu and launch the Preferences dialog, then go to the Miscellaneous 
page of the dialog and check the "Don't auto-set paper bin or media type" box. Click the OK 
button on the Preferences dialog to save your changes. 
 
2) Click the Properties button on the Print dialog to launch your Canon's printer-properties 
dialog, then set the media type to one of the "Printable Disc" options. 
 
3) Once you've clicked "OK" to close the printer-properties dialog, the paper bin on the label 
maker's Print dialog should be set to the CD-tray option. If it's not, set it to the CD-tray option 
now. 
 
This should stop the error from occurring. Remember that you'll need to change the media 
type and paper bin settings back again if you want to print on paper labels or inserts instead of 
printable discs. 
 
 
I've got a Canon printer, but the CD tray doesn't show up among the paper-bin options.
 
The CD tray won't show up among the paper-bin options for a Canon printer until you click on 
the "Properties" button in the Print dialog to launch Canon's printer properties dialog, and then 
change the media type to one of the printable-disc choices. 
 
If you bought your Canon printer in the US, though, it probably doesn't support printable-disc 
printing at all, and the CD tray option won't actually exist. We've been told that patent issues 
prevent Canon from selling CD-printing versions of their printers in the US, but we haven't 
seen official confirmation of this. 
 
 
When I print printable CDs or DVDs on my Epson printer, the discs come out with 
banding or other quality problems, yet they look fine when printing with the software 
that came with the printer. 
 
This problem is caused by having non-optimal printer-properties settings. Click the "Properties" 
button on the Print dialog in Acoustica CD/DVD Label Maker to launch the Epson's printer-
properties dialog, then check these settings: 
 
1) the print quality setting -- if it's set to less than the highest value, your discs may print with 
inferior resolution or color quality. 
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2) the media type -- if it's set to be any of the paper choices instead of being one of the 
CD/DVD settings, your printed CD may have banding problems. 
 
If fixing these two items don't solve the problem,  launch the printer-properties dialog in both 
Acoustica CD/DVD Label Maker and  the Epson-bundled software. If there are any differences, 
adjust Acoustica's settings to match the settings in the Epson software.  
 
 
When I print directly to CD, the ink doesn't stick - it bubbles up and wipes off easily. 
 
You can't print directly onto a normal CD; you need to buy printable CDs, which are labeled as 
such and usually have a white surface.  
 
You'll also need to know that there are two kinds of printable discs: thermal and inkjet. Make 
sure you're using the right type for your printer. The vast majority of direct-to-disc printers (and 
printable discs) are inkjet, so that's probably what you've got. If you try to print on a thermal 
printable disc in your inkjet printer, the ink won't stick to it; it'll just make a little puddle on your 
disc. If you try to print on an inkjet disc in a thermal printer, we're not sure what will happen; we 
haven't tried this yet. It's not likely to be good, though. 
 
If you print outside the printable areas on a printable disc, you'll find that ink will wipe off these 
areas easily. If this happens, make sure you've got the non-sticky ink wiped off before you 
insert the CD or DVD into a drive to play it. You might find that after buying a new batch of 
printable CDs, you're suddenly getting printouts that leave parts of the printable area on the 
disc unprinted or print onto unprintable areas of the disc. This occurs because different brands 
and models of printable discs have slightly different printable diameters. To fix this, launch the 
Edit Paper/Printer Templates dialog (accessible from the "File" menu) to adjust your disc & 
hole diameter settings to match the printable discs you've got. If you don't have a metric ruler 
handy (the settings on this dialog are all in millimeters, which are much easier than inches to 
work with when you're dealing with very small distances), the dialog can print one for you. 
 
 
Help Contents  
 
 
 
The Your-Label's-Too-Darn-Big Dialog 

 
 
If you're printing a label on plain paper and it's so big that it overlaps your printer's unprintable 
area or even the edges of the paper itself, you'll get to spend some time with this dialog. 
 
You can't print your label full size in all its glory, but Acoustica CD/DVD Label Maker will help 
you make the best of things. Here are your options: 
 
Scale the entire label down to fit:  This will make the entire label smaller so that it will fit on 
your paper. If you've got a DVD case label that's 10 millimeters too wide, this option will shrink 
the entire label to make it 10 millimeters narrower. The advantage is that everything you put on 
your label will still print, if at a slightly smaller size. The disadvantages are that the label will get 
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shrunk both horizontally and vertically, even though the paper was too small in only one of 
those directions, and because the label is getting rescaled, any fold lines that get printed might 
be slightly off. This option is probably the best available, though. 
 
Chop some millimeters off each side:   If your label is 10 millimeters too wide, the program 
will chop 5 millimeters off each side. This is good because your label will still be symmetrical, 
and it will only get chopped in one direction (i.e., horizontal or vertical, but not both). But it's 
bad because it chops off some of the label you worked so hard to create. It's a good option if 
you don't have any interesting content near your label edges. 
 
Ignore the overlap:  You can always pretend the overlap doesn't exist. If your label is 10 
millimeters too wide and you choose this option, the rightmost 10 millimeters will get chopped 
off. We don't think this is your best choice, but you may have your reasons. We won't pry. 
 
If you check the "Always print this way; don't ask me again" box before clicking the "OK" 
button, the program will use your choice to handle printer overlap from now on without asking 
you, so you'll never see this dialog box again. 
 
OK: click this button when you've made your choice and you're ready to move on. 
 
Cancel: click this button if you've decided you don't want to print this label after all. 
 
Help: we suspect you've already got some experience with this button. But if you enjoy this 
help page, feel free to click it whenever you want. 
 
What else? If you've got more than one printer, try 'em all. You might find that another of your 
printers has a small enough unprintable margin that the entire label will print on it without being 
shrunk. Or if you're sure your printer is capable of edge-to-edge printing, you made need to set 
an option in its printer-properties dialog (accessible from the Print dialog) or select a specific 
printer bin to print from in order to get your printer to actually print edge to edge. 
 
Printing 
 
Help Contents 
 
 
 
 
The Instant-Label Wizard 
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If you're in a CD-label-making race, or you don't trust your label design skills, or you just can't 
be bothered to plunge in up to your elbows among the muck of backgrounds and text and clip 
art, then Acoustica CD/DVD Label Maker's instant-label wizard is for you. We've done all we 
can to remove as many choices as possible, so that all you have to do is make a few mouse 
clicks and proceed to the printing. We couldn't remove all the choices, owing to the difficulty of 
licensing mind-reading technology, but the ones that remain aren't too hard. Those of us at 
Acoustica who've had some experience with the wizard have been known to get through it in 
under ten seconds. 
 
Every page of the wizard contains a series of buttons that let you navigate through the wizard. 
They are: 
 
< Back: go to the previous page 
 
Next >: go to the next page 
 
Cancel: exit the wizard, discarding everything you've done in it 
 
Help: launch this help page or a related one. The evidence would indicate that you already 
know about this one. 
 
Finish: only shows up on the last page. Closes the wizard and retains all the choices you've 
made. 
 
These links provide more detail on the various stages of the wizard: 
 
Choose a Label Type 
 
Choose a Theme 
 
Tracks 
 
Additional Text Fields 
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Finish 
 
You can launch the wizard by choosing the Instant-Label Wizard option from the File menu. If 
you want the wizard to launch every time you run the Label Maker program, you can specify as 
much from the Auto-Run Page of the Preferences Dialog. 
 
 
Help Contents  
 
 
 
Instant-Label Wizard "Choose Label Type" Page 

 
 
Choose whether you want to make your labels for a CD, a DVD, or a mini CD. A CD label set 
includes a CDDVD label plus the inserts for a standard jewel case. A DVD label set includes a 
CD/DVD label plus the inserts for a DVD case. A mini CD label set includes a mini-CD/DVD 
label plus an insert for a mini-CD jewel case. 
 
Once you've chosen your label type, click tne Next button to go to the Choose a Theme page.
 
The Instant-Label Wizard 
 
Help Contents  
 
 
 
Instant-Label Wizard "Choose Theme" Page 

 
 
Just by clicking on a theme in this list, you'll choose the background image, text fields, fonts, 
tracks format, and general all-around layout of all the labels for your CD or DVD. We think that, 
for efficiency and far-reaching power, this mouse click ranks right up there with the "self-
destruct this entire vast underground complex" buttons that the villains are always pressing in 
James Bond movies. 
 
Each of the themes in the list on this page displays three pictures representing approximately 
what your labels will look like if you choose that particular theme. If you're creating a CD 
project, the first picture, starting from the left, will be your disc label; the second will be your 
jewel case front booklet; and the third will be your jewel case back. 
 
Once you've chosen your theme, click the Next button to go to the Tracks page. 
 
The Instant-Label Wizard 
 
Help Contents  
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Instant-Label Wizard "Tracks" Page 

 
 
If you've gotten this far, you're rapidly getting the hang of this "wizard" business. This page lets 
you type in your tracks listing - either your song list, for an audio CD, or your chapter list, for a 
DVD. If you're running the audio CD wizard, you can also import your tracks from a playlist, if 
you have one, which will save you all that tedious typing. 
 
To type in the contents for a field in the contents list - i.e., "Song Title", "Artist", "Chapter", etc. -
click on the field and just start typing. Once the contents list has the keyboard focus, you can 
also move from field to field by using the arrow keys or the tab key. There are several other 
ways to get a field into edit mode. Here's the lot: 
 
press the Enter key: selects the text in the field and puts the caret at the end of the text 
press F2: selects the text in the field and puts the caret at the end of the text 
click the Edit button: selects the text in the field and puts the caret at the end of the text 
double-click the text field: selects the text in the field and puts the caret at the end of the text 
just start typing: replaces the contents of the field with whatever you're typing 
 
You can't edit the contents of the "number" field. We couldn't see the value of identifying song 
3 as "7" or "12" or "bx", but if you think you can convince us otherwise, send us an e-mail. If 
you want to change a track's position in the list, you can click the "Move Up" or "Move Down" 
buttons or just click on the song and drag it up or down. 
 
This page has several buttons along the right side of the window: 
 
Add Row: adds a new row to the end of the list. 
 
Remove: remove the currently selected row. 
 
Edit: lets you edit the text of the currently selected item. 
 
Move Up: moves the currently selected row one row up. 
 
Move Down: moves the currently selected row one row down. 
 
Import: this button will only be visible if you're working on an audio CD label. It lets you import 
tracks from a playlist file. When you burn a CD, you usually create a playlist file that lists the 
songs you burned to the CD. Acoustica CD Label Maker can read most types of playlist files, 
including the .cbs files generated by our own Acoustica MP3 CD Burner, and automatically 
create a song list for you. 
 
Read CD:  this button will be visible if you're working on an audio or data CD or DVD label and 
you have a CD/DVD drive attached to your computer. It will attempt to get tracks information 
from the CD or DVD in your drive. For audio CDs, if your CD has an entry in cdplayer.ini or 
cdburner.ini, the program will use it; if not, it will try to look up a tracks listing for your CD over 
the Internet. For data CDs and DVDs, it will just read all the files and folders off the disc. 
 
iTunes: If you've got iTunes installed on your computer, click this button and the label maker 
will attempt to find your iTunes library and read in all your playlists, so you can import an 
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iTunes playlist to Acoustica without having to export it from iTunes first. 
 
Data Type: This control lets you choose what kind of data you're displaying for your project. If 
you choose the Audio CD/DVD option, you'll get a standard audio playlist with song titles, 
artists, song lengths, etc. If you choose the Data CD/DVD option, you'll get a playlist for a Data 
CD, with file and folder names, file sizes, etc. If you choose the Video option, you'll get a 
playlist for a video disc, with chapter titles and lengths. 
 
Show Files & Folders, etc.: This combo box, only available if you've chosen the Data 
CD/DVD data type, lets you choose whether you want to display file names, folder names, or 
both. 
 
More: This button, only available if you've chosen the Data CD/DVD data type, launches the 
Data Layout Details dialog to let you set a variety of display options for the files and folders on 
your data CD playlist. 
 
Once you've got all your tracks info just the way you want it, click the Next button to go to the 
Additional Text Fields page. 
 
The Instant-Label Wizard 
 
Help Contents  
 
 
 
Instant-Label Wizard "Additional Text Fields" Page 

 
 
Depending on which theme you chose in the Choose a Theme page, your CD or DVD label set 
may display text for titles, dedications, artist names, etc. This page lets you type in the text you 
want for each of these fields. 
 
One you're satisfied with all your text fields, click the Next button to advance to the last page of 
the wizard. 
 
The Instant-Label Wizard 
 
Help Contents  
 
 
 
Instant-Label Wizard "Finish" Page 

 
 
Once you get to this page, your wizard is done. All you need to decide is whether you want to 
keep it or not. 
 
If you like what you've done, click the Finish button. This will close the wizard and keep all the 
label décor you picked out in the wizard.
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If you're having second thoughts, click the Cancel button. This will close the wizard and 
discard all the wizard decisions you're apparently starting to regret. 
 
 
The Instant-Label Wizard 
 
Help Contents  
 
 
 
The Tracks Dialog 

 
 

  
 
This dialog lets you type in and edit your tracks listing - your song list, for an audio CD or DVD; 
your file list, for a data CD/DVD; or your chapter list, for a video CD/DVD. If you're editing an 
audio CD, you can import your tracks from a playlist and save yourself all that tedious typing. 
You can also import files from audio and data CDs or DVDs. 
 
To type in the contents for a field in the contents list - "Song Title", "Artist", "Chapter", etc. - 
click on the field and start typing. Once the contents list has the keyboard focus, you can also 
move from field to field by using the arrow keys or the tab key. There are several other ways to 
get a field into edit mode. Here's the lot: 
 
press the Enter key: selects the text in the field and puts the caret at the end of the text
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press F2: selects the text in the field and puts the caret at the end of the text 
click the Edit button: selects the text in the field and puts the caret at the end of the text 
double-click the text field: selects the text in the field and puts the caret at the end of the text 
just start typing: replaces the existing contents of the field with whatever you're typing 
 
If the contents of a field are too wide to fit in the available space in the tracks list, you'll see a 
row of periods, like so: … at the end of the field. If you drag the mouse cursor over the field 
and let it sit there, a tooltip will pop up that displays the unabbreviated contents of the field. 
 
You can adjust the widths of the different columns in the tracks list by clicking on the borders 
between the columns and dragging them. This doesn't affect how wide the columns will be on 
any actual labels. You can also double-click on a column header's right boundary to 
automatically widen it to fit the widest text in the column. 
 
Like many another dialog, this one has a bunch of buttons. Here's what they all mean: 
 
Add Row: adds a new row to the end of the list. 
 
Remove: removes the currently selected row. 
 
Edit: lets you edit the text of the currently selected item. 
 
Move Up: moves the currently selected row one row up. 
 
Move Down: moves the currently selected row one row down. 
 
Import: this button will only be visible if you're working on an audio CD label. It lets you import 
tracks from a playlist file. When you burn a CD, you usually create a playlist file that lists the 
songs you burned to the CD. Acoustica CD/DVD Label Maker can read most types of playlist 
files, including the .cbs files generated by our own Acoustica MP3 CD Burner, and 
automatically create a song list for you. 
 
Read CD: this button will be visible if you're working on an audio or data CD or DVD label and 
you have a CD/DVD drive attached to your computer. It will attempt to get tracks information 
from the CD or DVD in your drive. For audio CDs, if your CD has an entry in cdplayer.ini or 
cdburner.ini, the program will use it; if not, it will try to look up a tracks listing for your CD over 
the Internet. For data CDs and DVDs, it will just read all the files and folders off the disc. 
 
iTunes: If you've got iTunes installed on your computer, click this button and the Acoustica 
CD/DVD Label Maker will attempt to find your iTunes library and read in all your playlists, so 
you can import an iTunes playlist to the label maker without having to export it from iTunes 
first. 
 
Formatting: This button will only be enabled if you checked the "Display Tracks on Current 
Label" option. It launches the Tracks Formatting Dialog,Tracks_Formatting_Dialog which lets 
you play with the display attributes of your tracks listing, including layout, fonts, colors, field 
display order, and which tracks fields should be visible and which should be hidden. 
 
Done: closes the window. 
 
Display tracks on current label: If you check this box, your tracks will be displayed on 
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whichever label you've got currently visible. If you uncheck it, they'll be hidden. 
 
Data Type: This control lets you choose what kind of data you're displaying for your project. If 
you choose the Audio CD/DVD option, you'll get a standard audio playlist with song titles, 
artists, song lengths, etc. If you choose the Data CD/DVD option, you'll get a playlist for a Data 
CD, with file and folder names, file sizes, etc. If you choose the Video option, you'll get a 
playlist for a video disc, with chapter titles and lengths. 
 
Show Files & Folders, etc.: This combo box, only available if you've chosen the Data 
CD/DVD data type, lets you choose whether you want to display file names, folder names, or 
both. 
 
Details: This button, only available if you've chosen the Data CD/DVD data type, launches the 
Data Layout Details dialog to let you set a variety of display options for the files and folders on 
your data CD playlist. 
 
 
Help Contents  
 
 
 
Tracks Formatting Dialog 

 
 
The Tracks Formatting dialog lets you quickly set the formatting, including visibility, font, color, 
and layout, for your various tracks fields. It also lets you save your favorite combinations as 
presets that you can access later with just a click or two. Changes you make in this dialog 
apply only to the current foreground label, so you can edit the formatting of your disc label 
without affecting the jewel case inserts, etc. 
 
You can launch this dialog by clicking the "Formatting" button on Acoustica CD/DVD Label 
Maker's Tracks Dialog. 
 
Here's what all the controls on this dialog do: 
 
Presets: This combo box contains all the system presets (the ones that ship with the software) 
and user presets (presets you saved yourself) for quick access. Selecting a preset will cause 
the software to format your tracks text with all the font properties (and optionally, the layout 
information from the "Arrangement" combo box) stored in that preset. 
 
To create presets of your own, click the "save" button. It's directly adjacent to the Presets 
combo box and has a little picture of a disk on it. This will launch a file-save dialog in which you 
can choose a name for your preset and decide whether you want your preset to store just font 
information or both font and layout information. (If you choose to save layout information, the 
preset will save the layout information from the "Arrangement" option you currently have 
selected.) 
 
Changed your mind about a preset you've created? To delete it, select it, then click on the 
Delete button. This one is next to the Save button & has a picture of a pair of scissors on it. (It 
will be disabled unless you've selected a user-created preset.) Before deleting your preset, the 
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software will prompt you so it can make sure you didn't click the Delete button by accident. 
 
Arrangement: This combo box contains a list of quick-layout options for the current label. (It 
contains the same options as the auto-format combo box that appears on the tracks object's 
toolbar after you select it.) Selecting an option from the Arrangement combo box will cause the 
software to format the layout of your tracks text to match the option you've selected. 
 
Fields: This list box contains a list of all your tracks fields. To edit the font formatting, visiblity, 
and text color for a particular field, select it in this list box, and the dialog will update itself to 
display the current font/color/visiblity settings for that field. 
 
You can use the up and down buttons next to the Fields list box to change the order in which 
fields display. If you want the Artist field to display before the Song Title field, for instance, 
select the Artist field, then click the Up button. 
 
Field is Visible: Check or uncheck this box to hide or show the currently selected field. 
 
Font:  The font/typeface combo box lists the font in which the currently selected field will 
display. 
 
Size: Use this combo box to change the font size in which the currently selected field will 
display. 
 
Bold: Check or uncheck this box to make the currently selected field display with either bold or 
normal weighting. 
 
Italic: Check or uncheck this box to toggle the currently selected field between italicized and 
non-italicized display. 
 
Underline: Check or uncheck this box to turn underlining on and off for the currently selected 
field. 
 
Text Color:  This pair of controls lets you control the color in which the text for the currently 
selected field gets drawn. The text color button displays the current text color. Click on it to 
change the color. 
 
The which-tracks combo box lets you set the text color for all tracks or just for odd- or even-
numbered tracks. If you select the "even-numbered tracks" option and then click on the text 
color button, for instance, the text color you choose will apply only to the current field in even-
numbered tracks.  
 
If you've chosen different colors for odd- and even-numbered tracks and you select the "All 
Tracks" option, the text color button will display the odd-tracks color on the left side of the 
button and the even-tracks color on the right side. (Selecting a color when the "All Tracks" 
option is chosen will set the color for both odd- and even-numbered tracks.) 
 
Using different colors for odd- and even-numbered tracks can make the tracks listing easier to 
read when it contains a large number of tracks. Make sure that both colors show up well 
against your chosen background art, though. 
 
The Tracks Dialog 
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Help Contents  
 
 
 
The iTunes Dialog 

 
 

  
 
The iTunes dialog searches your iTunes library and produces a list of all your iTunes playlists. 
Click on a playlist name in the Playlists listbox to see what's in that playlist. Once you've found 
the playlist you want, click the OK button, and Acoustica CD/DVD Label Maker will import the 
playlist you've chosen into your Tracks listing so you can display it on your labels. 
 
Replace Existing Tracks: if you check this option and then click OK to import an iTunes playlist, 
the playlist you've chosen will replace any tracks you already had in your tracks listing. If you 
uncheck this option, importing an iTunes playlist from this dialog will cause it to get appended 
to your current tracks listing. 
 
 
The Tracks Dialog 
 
Help Contents  
 
 
 
Playlist Search Dialog 

 
 
If you've got a playlist file that you want to import song names from, but you can't remember 
where the file is, then this dialog is for you. It will automatically search your hard drive and 
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display a list of all the files it finds that appear to be playlists. You can just scroll through, click 
on the one you want, and click "OK", and the label maker will automatically import that playlist 
for you. 
 
Here's what all the buttons on this dialog mean: 
 
OK: close the dialog and import tracks from the playlist file you've selected 
 
Cancel: close the dialog without importing any tracks 
 
Help: Given your presence here, we suspect you already know what this button does. 
 
Stop: tells the program to stop searching for playlist files. Once the search is complete, this 
button will become disabled. 
 
Replace Existing Files: If you check this box before importing a playlist file from this dialog, 
the tracks that get imported from that playlist will replace any existing track information. If this 
box isn't checked, tracks you import here will get appended to the end of your existing track 
information. 
 
If you're searching for an iTunes playlist, keep in mind that this dialog will only find playlists 
that you've exported from iTunes with the iTunes export feature. In this case, you'll find it faster 
and easier to click the iTunes button on the Tracks dialog instead, since the iTunes playlist 
dialog will read all your iTunes playlists instead of just the ones you've exported. 
 
The Tracks Dialog 
 
Help Contents  
 
 
 
Choose a CD Drive 

 
 
This dialog pops up when Acoustica CD/DVD Label Maker wants to know which of your many 
CD drives holds the CD that you're trying to read track information from. Your job is to tell it. 
Just click on the drive letter of the drive that holds your CD and then, once it's selected, click 
the "OK" button. If you're energy-conscious and you're trying to conserve mouse mileage, you 
can double-click on the drive letter instead. 
 
If you don't remember which drive holds the CD (but you're sure one of them does), you won't 
do any terrible damage by picking the wrong drive. The program will either import tracks for the 
wrong CD or display an error message indicating that there's no CD in the drive you picked. In 
either case, you can just click the "Import" button on the Tracks dialog again to rerun the 
process and select the right drive this time. 
 
Help Contents  
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"Choose a Disc ID" Dialog 

 
 
If FreeDB finds multiple potential matches for your CD, they'll all be displayed in this dialog. 
Choose the one that looks right to you. If it turns out to be wrong, click the "Import" button on 
the Tracks Dialog again and repeat the process and choose another one. 
 
When FreeDB finds multiple matches, they're usually multiple copies of nearly identical 
playlists, with slight variations in obscure fields that Acoustica CD/DVD Label Maker doesn't 
really care about. As long as the artist and album names are correct, you probably won't go 
wrong. 
 
Help Contents  
 
 
 
Data Layout Details Dialog 

 
 
This dialog, launched by clicking the Details button on Acoustica CD/DVD Label Maker's 
Tracks dialog, lets you set various display properties for the contents of data CDs and DVDs 
you've imported. (The Details button will only be visible if you've selected a Data-CD-type data 
set from the Tracks dialog.) 
 
In most cases, the changes you make here will only affect the current label you have selected 
for editing. If you've launched this dialog from the instant-label wizard, however, your changes 
will apply to all the labels in the current label set you're creating in the wizard. (If you want to 
edit per-label properties within a project you're creating from the wizard, you can finish the 
wizard, then select the label you want to change and bring up the Tracks dialog and click the 
More button.) 
 
What to Display: This combo box lets you choose whether you want your tracks display to 
include file names, folder names, or both.  
 
Nesting Levels: This control lets you decide whether you want to display the contents of 
subfolders of the CD or DVD you've imported. If the level is 1, your label will only display file 
and folder names from the root level of the disc you've imported. If you set it to 2, it will include 
the root level plus the immediate contents of any subfolders at the root level. If you set it to 3, it 
will include the contents of the root level's subfolder's subfolders. And so on. 
 
File Date Format: This control lets you decide how you want file dates to display.  
 
Folder Name Decoration: This control allows you to add special formatting to folder names so 
they're distinguishable from file names. If you select the "<Folder Name>" option, folder names 
will have greater than/less than symbols around them. If you select the "[Folder Name]" option, 
folder names will have square brackets around them. And if you select the "Names Only" 
option, folder names will have no special formatting, and will have the same appearance as file 
names. 
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Disc Summary: If you check this option, Acoustica CD/DVD Label Maker will create a new 
text field that lists information about the contents of the disc you've imported. Please note that 
the disc summary can only retrieve information from a disc-import operation (by clicking the 
"Read CD" button on the Tracks dialog). If you enter new file, folder or file size information by 
hand, or edit the file information on the Tracks dialog, the disc summary will ignore it.  
 
The Disc Summary option will be disabled if you've launched this dialog from the instant-label 
wizard. If you'd like to add disc summaries to particular labels, you can finish the wizard, then 
launch the Tracks dialog and click on the More button to launch this dialog again. 
 
Format: This control lets you select what information you want displayed in the disc summary. 
You can choose to display the total number of files and folders on the disc you've imported, the 
total size of all the files on the disc, and/or the range of dates (oldest and newest) of the files 
on the disc. 
 
Help Contents 
 
 
 
 
The Preferences Dialog 

 
 

  
 
This dialog collects a bunch of Acoustica CD/DVD Label Maker program settings that generally 
don't nicely fit into other categories and lets you edit them. You can launch the Preferences 
dialog by selecting the Preferences option from the File menu. 
 
The dialog contains several pages. Select which page you want to view and edit by clicking on 
the page names in the listbox on the left side of the dialog. 
 
Main Toolbar 
 
Auto-Run Options 
 
Printer Alignment 
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Stretch Labels 
 
Printing Fold Lines 
 
Miscellaneous 
 
 
Help Contents 
 
 
 
 
Preferences Dialog "Auto-Run Options" Page 

 
 

  
 
This page lets you decide whether or not to launch the new-label wizard The_Wizardevery 
time you start Acoustica CD/DVD Label Maker, and whether or not the program should 
automatically change the text justification when you switch a text object to a round 
background. 
 
The Always run the new-label wizard at program startup checkbox: 
 
If you check the "Always run the new-label wizard at program startup" box, the wizard will 
automatically run whenever you start the label maker. If you uncheck the box, the wizard will 
never run unless you explicitly tell it to by choosing the Instant-Label Wizard option from the 
File menu. 
 
Of course, there's an exception. If you launch the Acoustica CD/DVD Label Maker by double-
clicking on a label file in WIndows Explorer or by dragging a label file onto the Label Maker's 
program icon, the wizard won't run at startup even if you have the always-run checkbox 
checked. Our logic was that the wizard is used for creating a brand-new label, and if you're 
launching the program by double-clicking a label file, you don't want a new label, you want to 
edit the one you just double-clicked. We hope we have not erred in this assumption. 
 
The Remember last-used project type at program startup checkbox: 
 
By default, the software creates a blank CD project when it starts. If you check this box, it will 
remember the project type (CD, DVD, or mini-CD) you were working on the last time you used 
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the software and create a blank project of that type when you start the program. So if you were 
working on a DVD project the last time you ran the software, the next time it launches it will 
create a blank DVD project for you to work on. 
 
The Inquire about safety margins with printable discs checkbox: 
 
When you're printing directly onto a printable disc, the label maker will pop up a dialog asking 
whether or not you'd like to print with an extra one-millimeter safety margin around the label 
and hole boundaries. This is handy while you're working out your printer's alignment, but once 
you've got things locked in, you'll probably want to skip the safety margin and stop getting 
asked about it. If you check the "don't ask again" box on the safety-margin dialog, the label 
maker won't ask you on future print jobs whether or not you want to print with the extra margin; 
it'll just assume you don't. Unchecking the "Inquire about safety margins with printable discs" 
checkbox here serves the same purpose as checking the "don't ask again" box on the safety-
margins dialog. 
 
The When changing a text object's shape to round buttons: 
 
Lots of people think that if you display text within a round shape, the text will look goofy unless 
it's centered. Others say that non-centered text within a round shape can add dash and spice 
to an ordinary design, and can  rouse people to rethink their placid assumptions about the 
natural order of things, much like Stravinsky's Rites of Spring or the shower scene in Psycho. 
For our part, we've tried to remain agnostic about this. To accommodate all sides of this raging 
debate, we've added this set of buttons: 
 
Always center the text: when you change a text object to have a round shape, the program will 
automatically convert the text to centered justification. 
 
Never center the text: when you change a text object to have a round shape, we'll just pretend 
it never happened, at least from a text justification point of view. 
 
Always ask me: when you change a text object to have a round shape, we'll ask you whether 
or not you want us to center the text for you. 
 
 
The Preferences Dialog 
 
Help Contents  
 
 
 
Preferences Dialog "Main Toolbar" Page 
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This page lets you choose how you want Acoustica CD/DVD Label Maker's main toolbar 
(which runs across the top of the program's main window) to look. 
 
These are your options: 
 
Big icons with text: each toolbar button will have a 32 by 32 icon, plus text describing what 
the button does. 
 
Big icons, no text: each toolbar button will have just the 32 by 32 icon. 
 
Small icons with text: each toolbar button will have a 16 by 16 icon, plus text describing what 
the button does. 
 
Small icons, no text: each toolbar button will have just the 16 by 16 icon. 
 
No toolbar: the toolbar will not be visible at all. If you use this setting, please don't tell our 
artist. 
 
 
The Preferences Dialog 
 
Help Contents  
 
 
 
Preferences Dialog "Printer Alignment" Page 
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Printers are imprecise beasts. You can tell them to print something exactly 1.2 inches from the 
top of the paper, but chances are, it'll end up being more like 1.1 or 1.28 inches from the top. 
The older your printer gets, the more likely this is to occur, as all the little mechanical bits that 
escort paper into and out of the printer get worn out. You're not likely to notice this flaw when 
you're printing, say, a resumé. And if your interviewer is measuring the margins on your 
resumé, you may be happier elsewhere anyway. But when you're printing CD labels on a pre-
cut form, every millimeter matters. (That's why millimeters would rather be on a CD label than 
a plain sheet of paper - they like to feel important.) If your printer is a millimeter awry on a CD 
label, you'll get a millimeter of white, unprinted space on your label. It won't look good. 
 
However, if your printer is consistently wrong, which is often the case, you can use this dialog 
to correct it. If the printer always prints a millimeter to the right of where it's supposed to, you 
can use this dialog to tell the program to always print labels one millimeter to the left of where 
they'd normally go, which will cancel out the printer's imprecision and make things print just 
where they ought to be. 
 
Here's a summary of the controls on this page: 
 
When printing on: Lets you select the printer for which you want to set offsets. 
 
Move labels by: There's one of these sections each for horizontal and vertical paper 
alignment. Enter the amount of space, in millimeters, by which you need to move labels 
horizontally and vertically, respectively, for the printer you've chosen. 
 
To the left/To the right: Lets you select the direction in which to correct your printer's 
horizontal printing errors. If your printer always prints stuff too far to the right, check the "To the 
left" box. If it always prints too far to the left, check the "To the right" box. 
 
Up/Down: Lets you select the direction in which to correct your printer's vertical printing errors. 
If your printer always prints stuff too far down the page, check the "Up" box. If if prints too high, 
check the "Down" box. 
 
Don't apply to printable discs: If this box is checked, the printer-alignment settings you make 
here will be ignored when you're printing on printable discs. We recommend checking this 
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option. The printer alignment error that occurs when printing on paper from a paper tray is 
highly unlikely to be identical to any printer alignment error that occurs when you're printing on 
a CD tray inserted into the printer, so using the same settings for both is likely to create as 
many problems as it solves. We recommend using the alignment settings on this dialog to 
account for paper-related alignment errors, and using the Edit Paper/Printer Templates dialog 
(which you can launch from the File menu) to account for any printable-disc alignment error. 
 
If your printer doesn't align correctly, but isn't consistent about it, you can correct it by telling 
Acoustica CD/DVD Label Maker to stretch labels when it prints them. You can set the stretch 
amount on the Stretch Labels Preferences_Dialog_Stretch_Labels_Pagepage. 
 
The Preferences Dialog 
 
Help Contents  
 
 
 
Preferences Dialog "Stretch Labels" Page 

 
 

  
 
This dialog lets you account for printer alignment errors by telling Acoustica CD/DVD Label 
Maker to stretch all your labels when it prints them. If your printer doesn't print precisely where 
it's supposed to, but it's always off in exactly the same way, you can use the printer alignment 
dialog Preferences_Dialog_Printer_Alignment_Pageto fix it. If it's not wrong consistently 
enough, however, you'll need to use the brute force method of stretching all the labels by a 
millimeter or two, which will result in the label being slightly larger in every direction. So even if 
your printer prints too high one pass, and too low the next, or likes to feint left and print right, 
you'll be set. 
 
We generally recommend setting the stretch labels amount at one to two millimeters. We also 
recommend that you don't put important stuff, such as text, within a millimeter or so of your 
label borders or the CD hole unless you have a fabulously reliable printer, because otherwise it 
stands a good chance of getting chopped off when you print it. 
 
But don't stretch plain-paper labels: This checkbox lets you specify whether or not you want 
to apply your stretch settings to labels you print on plain paper. By default, this box will be 
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checked, which is our recommendation. The stretch labels settings are designed to overcome 
problems with your printer's alignment so that you can fit labels onto premade forms. But since 
plain paper doesn't have any pre-perforated labels that you need to line your labels up with, 
stretching isn't necessary, and in fact will only make your labels bigger than they need to be. 
 
 
The Preferences Dialog 
 
Help Contents  
 
 
 
Preferences Dialog "Printing Fold Lines" Page 

 
 

  
 
This page lets you set options for printing fold lines on your labels. You can turn fold line 
printing on and off from the Print DialogPrinting. If you turn them on, the program will print lines 
on your labels to help you fold them correctly. You don't need to check this box unless you're 
printing on plain paper; most stock paper forms have folds already built into the paper. If you 
check this box for the jewel case back, Acoustica CD/DVD Label Maker will print lines 
indicating where to fold the two spines. If you check this box for the jewel case front/inside, the 
label maker will print a line indicating where to fold the front/inside booklet in half. (The box will 
be disabled for the front/inside label if you're not printing on a paper type that prints both the 
front and inside labels on the same side of the paper.) You won't be able to check this box for 
the CD disc label, because there's nothing to fold on a CD or DVD label. 
 
The Fold Line Options: 
 
Solid Lines: If you check this radio button, the program will print solid fold lines. 
 
Dashed Lines: If you you check this radio button, the program will print dashed fold lines. 
 
Print lines outside the label only: If you don't check this box, the program will print fold lines 
on your labels to indicate where you need to fold them. If you check this box, the program 
won't print fold lines on your labels; it will print short lines just outside your label boundaries to 
indicate where you should fold your labels. If you use this option, there won't be lines on your 
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label, but you'll have to eyeball things a bit to get your fold lines right. 
 
Color: This option lets you choose what color you want your fold lines to be. The colored 
rectangle to the right of the "color" text will display your currently chosen fold line color. You 
can click on this rectangle or the "Change Color" button to choose a new color. 
 
 
The Preferences Dialog 
 
Help Contents  
 
 
 
Preferences Dialog "Miscellaneous" Page 

 
 

  
 
This page lets you set a variety of options that don't fit neatly into any of the other preferences 
categories. 
 
Embed images in saved files: If this box is checked, whenever you save a project, all the 
images you used in the project will get saved inside the project file itself. Checking this box will 
be a big help if you plan to copy a project to another computer, or if you're planning to delete, 
move, or rename any of the image files you used when you were designing the labels in your 
project. However, since it embeds a full copy of each image in your saved project file, those 
files will be much larger as a result. 
 
If you're pressed for hard-drive space, uncheck this option, and then instead of storing the 
image file itself in your project files, it will just store the path and file name of the images, and 
load them separately each time you subsequently open your project. Your project files will be 
much smaller, but you'll need to make sure you haven't moved, renamed, or deleted any of the 
image files you used, or the label maker won't be able to find them when you try to reopen the 
project. 
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You can override the setting you've made here for any project. When you bring up the "Save 
As" dialog, there will be an "Embed images inside file" checkbox on the dialog so you can turn 
image embedding on or off for particular projects. The checkbox may be checked and disabled 
if you've saved the project previously with embed-images enabled (in which case the label 
maker may no longer know where to find the original image files) or if you've pasted images 
from the clipboard onto a label in your project (since clipboard images exist only in memory 
and don't have file names, they must be embedded in the project file). 
 
Extra High Contrast Window Background: Checking this option will cause the window 
background behind the labels you're editing to be darker than normal, so if you have a monitor 
with poor contrast ability, you can still see where the edges of your labels are.  
 
Create a log file:  If you check this box, Acoustica CD/DVD Label Maker will log various 
events to a special text file. This will slow down the label maker, so we don't recommend using 
it except under special circumstances. You should only need to check this box if something 
freakish is occurring with the label maker and someone at Acoustica has asked you to turn 
logging on and send us the file so we can try to figure out what's going on. In all other 
circumstances, leave this box unchecked. 
 
Don't auto-set paper bin or media type: When you're printing a printable CD or DVD on an 
Epson or Canon printer, the label maker will attempt to automatically set the paper bin and/or 
the media type to use when printing. It does this because the printer will display an error 
message and refuse to print if the correct settings aren't made. For Epson printers, the 
software will set the paper bin to the "Manual" option (which corresponds to the CD tray). For 
Canon printers, the software will set the paper bin to the "CD Tray" option, and if the media 
type is set to one of the paper values, it'll set it to the "Printable disc (recommended)" option.  
 
The label maker only sets these options when you're printing on a printable disc; when you're 
printing on paper, you'll get whatever options you already had selected. If you check the Don't 
auto-set paper bin or media type box, the label maker will no longer automatically set these 
values. 
 
 
The Preferences Dialog 
 
Help Contents  
 
 
 
The Text Properties Dialog 
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You can do a surprising number of things to the text in a text object, and, aside from editing the 
text itself, you can do them all from the text properties dialog. You can access the text 
properties dialog by right-clicking on a text object and selecting Properties or by clicking the 
properties button (the one with the three little dots on it) on a text object's toolbar. 
 
This dialog consists of a series of pages for editing different aspects of a text object. Clicking 
on different lines in the list on the left side of the dialog will select different pages. 
 
If you check the "Apply changes as soon as I make them" checkbox, any changes you make 
will be reflected in the text object as soon as you make them. This is not completely 
conventional behavior for dialog windows, which normally require you to press the "OK" button 
before showing you your changes. But we hate the blundering around we have to do when we 
make changes in a dialog but we can't really tell what we've done until we close the dialog - 
and then we have to relaunch the dialog if it turns out it wasn't what we wanted. It's like flying 
an airplane by instruments alone:  it takes a lot of expertise to do it well, and most people, 
including us, don't have that kind of expertise. So we added the Apply changes checkbox. We 
think you'll like it. 
 
If you don't have the "Apply changes as soon as I make them" checkbox checked, changes 
you make won't take effect until you click the OK or Apply buttons. 
 
Clicking the Cancel button will close the dialog and reverse any changes you've made, unless 
you've clicked the Apply button; in that case, clicking the Cancel button will still close the 
dialog, but it will only reverse changes you've made since the last time you clicked the Apply 
button. The Apply button will be disabled if you've got the "Apply changes as soon as etc." box 
checked, because your changes will already be getting "applied" as soon as you make them. 
 
Text Properties Dialog "Font" Page 
 
Text Properties Dialog "Text Angle" Page 
 
Text Properties Dialog "Text Color" Page

Page 56 of 85

6/13/2006file://C:\acoustica\cdlabelmaker\help\cd-label-maker-flat.htm



 
Text Properties Dialog "Size & Position" Page 
 
Text Properties Dialog "Margins" Page 
 
Text Properties Dialog "Paragraph" Page 
 
Text Properties Dialog "Curving" Page 
 
Text Properties Dialog "Background" Page 
 
Text Properties Dialog "Color/Transparency" Page 
 
Text Properties Dialog "Justification" Page 
 
Text Properties Dialog "Word Wrapping" Page 
 
Text Properties Dialog "Columns" Page 
 
Text Properties Dialog "Fields" Page 
 
Text Properties Dialog Individual Field Pages 
 
 
Help Contents  
 
 
 
Text Properties Dialog "Text Color" Page 

 

  
 
This page lets you change the color in which your text is displayed. If you had a section of text 
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selected when you launched the Text Properties dialog, changes you make here will only 
affect the color of the text you've got selected. If you didn't have any text selected, your 
changes will affect the color of all text in the text object. 
 
Acoustica CD/DVD Label Maker displays selected text in the standard Windows selection 
colors, so if you change the text color of a text selection, you won't actually be able to see the 
color change until you close the dialog and unselect the text. 
 
In the current incarnation of the Label Maker, you can't create new custom colors from this 
page. To create custom colors, you have to click on the color button on a text object's toolbar.
 
Aside from these caveats, using this page is pretty simple. Click on a color, and your text will 
become that color. 
 
The Text Properties Dialog 
 
Help Contents  
 
 
 
Text Properties Dialog "Background" Page 

 
 

  
 
This page lets you choose the shape of a text object you've created with Acoustica CD/DVD 
Label Maker. You can select from these categories: 
 
Shape: Rectangle or Round 
 
Choose rectangle, and your text object will have a rectangular background. Choose round, and 
its background will be roundish (to be precise, it will be an ellipse). 
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Speech Balloon 
 
This feature lets you make your text object into a speech or thought balloon, such as you have 
probably seen thousands of times in the newspaper comics pages, or in comic books, or on 
billboards, or, perhaps, in an imaginative moment, in the clouds. Select Speech Balloon, and 
your text object will have a triangular tail that you can drag around and resize until it points 
wherever you wish. Select Thought Balloon, and your text object will trail a series of little 
thought balloonlets,  which you can likewise drag and resize. Select None for a traditional, 
balloon-free text object. 
 
You can't resize or move your thought or chat balloons from inside the Text Properties Dialog. 
To resize or move your chat/thought balloons, you need to exit the dialog and click on your text 
object's chat tail or one of its little thought balloonlets. This will cause three size markers to 
appear. You can drag these about to move or resize your text object's chat or thought tail. If 
you want to move the chat or thought tail to another side of your text object altogether, direct 
your attention to: 
 
Balloon Tail Location 
 
This group of radio buttons will be enabled if you've chosen the "Speech Balloon" or "Thought 
Balloon" options on this page. These buttons let you select the side of your text object on 
which you want to display your chat or thought balloon tail. 
 
The Text Properties Dialog 
 
Help Contents  
 
 
 
Text Properties Dialog "Color/Transparency" Page 
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This page lets you choose your text object's background color. It's quite simple: click on a 
color, and your text object's background will become that color. Or, if you'd prefer your text 
object to have a transparent background, you can check the "Transparent" box. 
 
Text Properties Dialog 
 
Help Contents 
 
 
 
 
Text Properties Dialog "Font" Page 

 
 

  
 
This page lets you change the fonts used for displaying the text in your text object. Bring this 
page up by clicking on the "Font" line in the listbox on the left side of the text properties dialog.
 
If you had a section of text selected when you launched the text properties dialog, changes on 
this page will only affect the text you've got selected. If there's no text selected, your font 
changes will apply to all the text in the text object. 
 
You've probably seen controls resembling all the ones on this page before. The "Font" 
dropdown list lets you choose a different typeface. The  "Size" dropdown list lets you choose 
your font size. The Bold, Italic, Underline, and Strikeout checkboxes let you apply (or not) 
these effects. 
 
The Text Properties Dialog 
 
Help Contents  
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Text Properties Dialog "Justification" Page 

 
 

  
 
This page lets you choose your text's horizontal and vertical justification. It works as follows: 
 
Horizontal 
 
Left: Text will be left-justified within the text object's boundaries. 
Center: Text will be centered horizontally within the text object's boundaries. 
Right: Text will be right-justified within the text object's boundaries. 
 
Vertical 
 
Top: Text will be top-justified within the text object's boundaries. 
Center: Text will be centered vertically within the text object's boundaries. 
Bottom: Text will be bottom-justified within the text object's boundaries. 
 
If you're dealing with text on a CD label, the text's justification could also be affected by the 
word wrapping options you've selected. 
 
Text Properties Dialog 
 
Help Contents  
 
 
 
Text Properties Dialog "Margins" Page 
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This page lets you change your text object's horizontal and vertical margins. Setting these 
fields lets you increase or decrease the amount of space between your text object's borders 
and where the text will be allowed to print. Setting a left margin of 1 centimeter, for instance, 
means that text will start printing 1 centimeter to the right of the text object's left border, not 1 
centimeter to the right of the label's border. 
 
If you're settings margins for text on a CD or DVD label, the margins will affect not just the 
text's distance from the edges of the label, but from the edges of the label hole as well. 
 
The Text Properties Dialog 
 
Help Contents  
 
 
 
Text Properties Dialog "Size & Position" Page 
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This page lets you change the size and position of your text object. This is probably easier to 
do outside the text properties dialog, simply by clicking on a text object's title bar and dragging 
it to move the object, or by dragging one of the text object's red resize bars to resize it.  
 
However, if you're the punctilious sort, or you believe that the dimensions of all elements in 
your labels must be factors of the Fibonacci sequence, or of the lotto numbers that made you a 
millionaire, then this page will be just your pace. In that case, you can just type your favored 
location and width and height into the provided fields. 
 
Note: "distance from label top" and "distance from label left" refer to distance from the top and 
left of your label's bounding rectangle. So if you're editing the position of a text object on a CD 
label, which you have probably noticed is circular, the left and top distances measure from the 
spot you would get if you made an imaginary rectangle completely enclosing the label. 
 
The Text Properties Dialog 
 
Help Contents 
 
 
 
 
Text Properties Dialog "Text Angle" Page 
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This page lets you change the angle at which your text displays. Bring this page up by clicking 
on the "Text Angle" line of the listbox on the left side of the text properties dialog. 
 
If you click the 0 degrees (normal) checkbox, your text will display in normal, right-side-up 
fashion, just like you're used to seeing it. 
 
If you click the 90 degrees (straight up) checkbox, your text will climb straight up the label. 
 
If you click the 270 degrees (straight down) checkbox, your text will descend straight down the 
label. 
 
If you click the 180 degrees (upside down) checkbox, your text will display upside down, 
starting at the bottom of your text object. 
 
If you're having a hard time picturing any of this, check the "Apply changes as soon as I make 
them" box, and then start checking the different boxes described above. You'll catch on in no 
time. 
 
If you set your text to any angle other than 0 degrees (normal, right-side-up text), you won't be 
able to edit the text by just clicking on the text object. Instead, its toolbar will grow a new button 

 that opens a text editing window. For more information, see the "Edit Text" window for 
angled text. 
 
The Text Properties Dialog 
 
Help Contents  
 
 
 
Text Properties Dialog "Word Wrapping" Page 
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This page contains some esoteric stuff that affects how your text will word-wrap.  
 
Ignore Label Edges: If you check this box, you can drag a text object partially off a label, and 
it won't affect how the text object word-wraps. The result will be that some of the text in the text 
object won't be visible, because it will be off the label. If you uncheck this box, dragging a text 
object partially off a label will cause the text to word-wrap when it reaches the label boundary 
instead of waiting until it reaches the text object's margin.  
 
Hole Handling: These options let you choose how you want your text to word-wrap when it 
encounters the hole in the middle of a CD or DVD label. Your choices are: 
 
Ignore Holes: Pretends the hole isn't even there. If you select this option, text that crosses the 
hole will be invisible, because the text object won't try to wrap around it at all. 
 
Wrap on left side: Wrap text to the left side of the hole. If your text object lies entirely to the 
right side of the hole, this setting may produce unhappy results. 
 
Wrap on right side: Wrap text to the right side of the hole. If your text object lies entirely to the 
left side of the hole, this setting may produce unhappy results. 
 
Wrap on widest side: Wrap text on whichever side of the hole has the most room within the 
text object's boundaries. 
 
Wrap on both sides: Wrap on both sides of the hole. Print as much text as will fit on the left 
side of the hole, then skip over to the right side of it and print text there as well. 
 
Skip to bottom of hole: Go around the hole entirely, and don't resume printing until you've 
gotten to the bottom of it. 
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Text Properties Dialog 
 
Help Contents  
 
 
 
Text Properties Dialog "Fields" Page 

 
 

  
 
This page, which only appears on the properties dialogs of tracks text objects, lets you choose 
between fixed and variable field widths. 
 
In fixed-width mode, all rows of a field will be the same width. If you set the "track name" field 
to be 2.5 centimeters wide, every track will have a 2.5-centimeter-wide track name. All rows 
will line up exactly underneath each other, like the rows in a spreadsheet or a table in a word 
processor. 
 
In variable-width mode, each field of each row will be exactly as wide as required to display the 
amount of text. The title field for "You've Certainly Got a Lovely Bunch of Coconuts" will be 
wider than the title field for "Louie Louie." The rows in the text object will not line up directly 
underneath each other, unless all their text fields happen to be exactly the same length. 
 
In variable-width fields mode, there will be a fixed amount of space between fields. If you 
specify 1.2 centimeters after the track number field, every row will have 1.2 centimeters of 
blank space between its row number and the field that follows it, no matter how wide individual 
track numbers may be. When you're in variable-width fields mode and you drag the field 
borders in the header bar, you're actually editing the width of the distance between the fields 
rather than the widths of the fields themselves. 
 
Fixed width fields work well for left-justified text or cases where you've got more than two fields 
visible. The variable width fields setting can have a nice effect on centered or right-justified 
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tracks listings. 
 
Line Break After Each Row: If this box is checked, each track listing will start on a new line. If 
it's unchecked, multiple tracks will appear on each line, space permitting. 
 
Space After Each Row (cm): If there's not a line break after each track, this control specifies 
how much space should appear between tracks that display on the same line. This control will 
be disabled if the Line Break After Each Row control is checked.  
 
Text Properties Dialog 
 
Help Contents  
 
 
 
Text Properties Dialog Individual Field Pages 

 
 

  
 
When you launch the text properties dialog for a tracks text object, you'll see one of these 
pages for each field in the text object. For an audio CD, they'll be labeled Number, Song Title, 
Artist, Length, and so on. This page lets you edit properties of whichever tracks field you've 
selected. 
 
If you check the Field is visible checkbox, the field will be displayed on the label. Uncheck it 
to hide the field. 
 
The Field width edit control lets you decide how wide you want the field to be, provided you've 
got the text object in fixed-width fields mode (you can set this on the Text Properties Dialog 
"Fields" Page). If you're not a numbers-oriented sort of person, you can also do this outside the 
text properties dialog by clicking on the text object to select it and then dragging the field 
boundaries in the header bar to resize them.
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The Space after field lets you decide how much blank space you want between this field and 
the next one, provided you've got the text object in variable-width fields mode (you can set this 
on the Text Properties Dialog "Fields" Page). You can also do this outside the text properties 
dialog by clicking on the text object to select it and then dragging the column boundaries in the 
header bar to resize the spaces between them. 
 
For an explanation of fixed vs. variable width fields modes, check out the Text Properties 
Dialog "Fields" Page. 
 
Text Properties Dialog 
 
Help Contents  
 
 
 
Text Properties Dialog "Columns" Page 

 
 
This page, which only appears on the properties dialogs of tracks text objects, gives you the 
option to display your CD tracks in multiple newspaper-style columns. 
 
How Many: This control lets you specify how many columns you want. 
 
Style: This control lets you specify how you want your text split between columns. In balanced 
mode, each column will contain an equal number of tracks (or as close to equal as possible). 
In front-loaded mode, the first column will hold as many tracks as will fit, then the second 
column will hold as many of the remaining tracks as it can fit, etc. 
 
Margin between columns (cm): This control lets you specify a margin that will appear 
between each column, in centimeters. 
 
The other controls on this page apply to particular columns. They'll be disabled unless you've 
set the how-many-columns control to be 2 or more. 
 
Column Number: specifies which column the Horizontal Orientation and Hole Wrapping 
controls apply to. 
 
Horizontal Orientation: specifes the horizontal orientation for text in the currently selected 
column. 
 
Hole Wrapping: specifies the hole wrapping mode (what to do when the text encounters the 
CD hole) for the currently selected column. 
 
Text Properties Dialog 
 
Help Contents  
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Text Properties Dialog "Paragraph" Page 

 
 
Line Spacing: This control lets you set line spacing for a text object. 1.0 means single-spaced 
text; 2.0 means double-spaced text, etc. 
 
Extra Indentation: These controls let you specify extra text indentation on a per-paragraph 
level. If your text is left-justified, the extra indentation will be on the left; if your text is right-
justified, the extra justification will be on the right; if your text is centered, extra indentation 
doesn't apply and these controls will be disabled. 
 
1st Line (cm): Lets you specify, in centimeters, extra indentation for the first line of every 
paragraph. 
 
Other Lines (cm): Lets you specify, in centimeters, extra indentation for all non-first lines of 
paragraphs. 
 
Text Properties Dialog 
 
Help Contents  
 
 
 
Text Properties Dialog "Curving" Page 

 
 
This page lets you make your text curved (or not), and lets you set various properties for how 
curved text should behave. 
 
Text Curving: 
 
Straight: With this setting, your text will display in a straight line. Since most of the other 
options on this page all relate to curved text, they'll be disabled if you've selected the straight-
text setting. 
 
Curved: With this setting, your text will display in a circle (or an ellipse, to be more exact). 
 
Spiral: With this setting, you text will display in a spiral. 
 
Fit Curve to Label: If you check this box, the ellipse that your curve follows will automatically 
be centered on the label and will have the same aspect ratio as the label. It's the default 
option. Check this box if you want your text to curve around the edges of the label. If you 
uncheck this box, your text will fit itself to the bounding rectangle of your text object, and you 
can resize the text object to change the dimensions of the ellipse that your text follows. 
 
Curve Direction: 
 
Clockwise: Curved text will circle your label in a clockwise direction. 
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Anti-Clockwise: Curved text will circle your label in an anti-clockwise direction. 
 
Auto Choose: Curved text will circle in a clockwise direction if it's primarily on the top half of the 
label, and anti-clockwise if it's primarily on the bottom half. For spiral text, it will always go 
clockwise. If you have the Fit Curve to Label option checked,  your text object will be centered 
on the label, so it will usually go clockwise. 
 
Starting Angle: 
 
Use Horizontal Orientation: The software will use your horizontal-orientation setting to 
determine where the text should start. If you've chosen left orientation,  the text will start at the 
leftmost edge of your text object. If you've chosen right orientation, it will end at the rightmost 
edge of your text object. If you've chosen centered orientation, the text should both start and 
finish an equal distance from the center of your text object. Note that if your text is in spiral 
mode and it fills more than one complete revolution, the text will be treated as if it's left 
justified, regardless of your horizontal orientation setting. 
 
Fixed Angle: The text will begin at the angle you choose. 0 degrees is directly to the right (3 
o'clock). The angle increases in a counterclockwise direction, so 12 o'clock is 90 degrees, 9 
o'clock is 180 degrees, and 6 o'clock is 270 degrees. If you've got the Fixed Angle setting 
checked, you can click on the circle to the right of the "Fixed Angle" radio button to choose a 
start angle, or you can use the spin control on the edit box underneath the "Fixed Angle" radio 
button to adjust your start angle by one degree at a time. 
 
The Text Properties Dialog 
 
Help Contents  
 
 
 
New Project Dialog 

 
 

  
 
This dialog lets you start fresh with a brand new, blank set of labels. All you need to do is 
decide what sort of new label you want to create: 
 
CD with jewel case: this creates a project with a CD label, a CD jewel case insert to slide into 
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the front of your jewel case, and a CD jewel case back insert to attach inside the back of the 
jewel case. 
 
DVD with DVD case: this creates a project with a DVD label, a DVD case cover for wrapping 
around the inside of a DVD case, and a DVD case insert for inserting into the left-front panel of 
the inside of the DVD case. 
 
Mini/Pocket CD: this creates a project with a mini CD label (a CD with an 8-centimeter 
diameter instead of a normal CD's 12-centimeter diameter), plus a jewel case insert to slide 
inside a mini-sized jewel case. 
 
 
 
Help Contents  
 
 
 
Save As Theme Dialog 

 
 
This dialog lets you save your current project as a theme that will show up with all the artist-
built themes in Acoustica CD/DVD Label Maker's Instant-Label Wizard. How often do you get 
the chance to see your work displayed alongside the work of professional artists?  
 
New Theme Name: Enter a name for your new theme here. It will appear under this name in 
the Instant-Label Wizard after you've saved it. 
 
Stuff to Save: 
 
Text Objects: If you check this box, any text objects on the labels in your project will get saved 
in the theme. 
 
Images: If you check this box, any images in your project, both foreground and background, 
will get saved in your theme. 
 
Colored Shapes: If you check this box, any shapes you've added to your project will get saved 
in your theme. 
 
Background Color: If you check this box, the background colors you've selected for the labels 
in your project will get saved in your theme. 
 
 
Help Contents  
 
 
 
Tiled Background Settings Dialog 
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This dialog lets you set an image from your computer as a tiled label background and control a 
variety of settings for how the image gets tiled. Here's what all the controls do: 
 
Real-Time Preview:  If you check this box, any changes you make will display on the label 
immediately, so you can see how well they work. If you uncheck it, you won't be able to see 
your changes until you click the OK button to exit the dialog. 
 
150 DPI: This option will tile the image at 150 dots per inch. It's the default option for bitmap-
based images. (For vector-based images, such as WMF files, dots per inch effectively has no 
meaning, so you'll have to set custom rows and columns.) If you tile at resolutions lower than 
150 DPI, there's a good chance the image could begin to look grainy or distorted when you 
print it.  
 
300 DPI: This option will tile the image at 300 dots per inch. 
 
Custom DPI: This option will let you tile the image at the dots-per-inch resolution of your 
choice. 
 
Custom Rows/Columns: This option will let you choose your tiling resolution in rows & 
columns instead of dots per inch. 
 
Keep Aspect Ratio: This option only applies to the Custom Rows/Columns tiling mode. If it's 
checked, the image will always maintain its original aspect ratio, so if you change the number 
of rows, the number of columns will automatically change to keep the aspect ratio constant, 
and vice versa. If you uncheck this option, you can set both rows and columns precisely, but if 
you change the aspect ratio, the image could appear stretched or squished. 
 
Cropping Controls: The cropping options let you crop the image so that portions of it don't get 
displayed. The cropping amounts you specify in these controls are measured in pixels. The 
default is 0 pixels (no cropping at all).  
 
Justification:  These options let you control horizontal and vertical justification for your image. 
You can align your image to the left or right edges of your label, or center it. You can align it 
vertically to the top or bottom edge of the label, or make it centered vertically on the label. 
 
Blend Edges: This option will blend the edges of the image together so that there's not a 
visible seam between the tiles. This option generally works best on images that don't have 
sharply defined contours or objects on them - a photograph of clouds, for instance, would be a 
good candidate for the blend-edges effect. If you're not sure whether or not it will work for your 
image, go ahead and check the box and see. It takes almost no effort, after all - you'll consume 
less than half a calorie, in our judgment - to uncheck the box again if it doesn't look good. 
 
 
Help Contents  
 
 
 
The Printer Calibration Wizard 
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If your printer just can't seem to line up your labels correctly on your label sheets, this wizard 
can help. It prints a test sheet that helps you measure how much alignment error your printer 
has and then automatically compensates for it on future printouts. 
 
Please note that since this wizard works by printing calibration tests on paper, it works well for 
handling alignment errors on label paper, but isn't suited for handling alignment errors for CD 
trays that you insert into your printer for printing directly onto printable CDs or DVDs. To align 
your printable CDs, try using the "Edit Paper Templates" Dialog, which you can access from 
the "File" menu.  
 
Printer Calibration Wizard Test-Sheet Page 
Printer Calibration Wizard Alignment Page 
Printer Calibration Wizard Finish Page 
 
Help Contents  
 
 
 
The Printer Calibration Wizard: Print a Test Sheet Page 

 
 
On this page of the wizard, you'll intialize your printer to print an alignment test sheet that you 
can use to measure how far off your printer's alignment is. Once you click the "Next" button, 
the wizard will print the alignment test sheet on the printer you've chosen on this page. 
 
Printer: Choose the printer you're testing alignment for. Make sure the printer is turned on and 
hooked up to your computer before you click the "Next" button. 
 
Paper Bin: Choose the paper bin that you want your printer to use for printing the alignment 
test page. 
 
Properties: Click this button to launch your printer's custom properties dialog, which lets you 
set features unique to your printer, such as print quality, ICM management, etc. The alignment 
test sheet is a simple black-and-white printout, so it's unlikely that you'll need to make any 
adjustments here. 
 
Number of Copies: Decide how many copies of the alignment test sheet you want to print. 
Just printing one will help, but printing multiple copies and comparing them will help you 
determine whether your printer's alignment is off by a consistent amount or whether it varies 
from print job to print job.  
 
If your alignment does vary from sheet to sheet, it's difficult to pick a precise alignment amount 
that will work. You might try picking average values and then using the stretch settings on the 
Printer Alignment dialog (click the "Alignment" button on the Print dialog to get to the Printer 
Alignment dialog). 
 
Paper Size: Choose the paper size that you'll be printing your alignment test sheet on.  
 
One more note on paper alignment: be sure your paper fits snugly in the paper tray, and 
there's no space between the edges of the paper and the tray's paper guides. If your paper 
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has room to slide around inside the paper tray, there's a good chance that this will cause 
alignment errors on a large variety of printer models. 
 
Printer Calibration Wizard Intro Page 
Printer Calibration Wizard Alignment Page 
Printer Calibration Wizard Finish Page 
 
Help Contents  
 
 
 
The Printer Calibration Wizard: Alignment Page 

 
 
On this page of the wizard, you'll enter the horizontal and vertical offsets to account for the 
alignment error you measured on the aligment-test sheet that just printed. 
 
Horizontal Adjustment: Unfold the sheet you printed, turn it sideways, and see where the fold 
crease crosses the axis labeled "Horizontal Offset". Enter the number you measure in this edit 
control. If the fold crease is above the center line, you'll be entering a negative number. If the 
crease doesn't have the same offsets on the two grid lines at the edges of the sheet as it does 
on the center grid line/axis, it's an indication that your printer feeds paper through itself 
crookedly. (Although it could mean that you just didn't fold the sheet perfectly -- check that 
first.) If it doesn't feed straight, try using the value at the center of the sheet and then 
compensating for the printer's drift with the stretch settings in the Printer Alignment dialog 
(accessible by clicking the "Alignment" button on the Print dialog). 
 
Vertical Adjustment: Unfold the sheet you printed, turn it right-side up, and see where the 
fold crease crosses the axis labeled "Vertical Offset". Enter the number you measure in this 
edit control. If the fold crease is above the center line, you'll be entering a negative number. If 
the crease doesn't have the same offsets on the two grid lines at the edges of the sheet as it 
does on the center grid line/axis, it's an indication that your printer feeds paper through itself 
crookedly. (Although it could mean that you just didn't fold the sheet perfectly -- check that 
first.) If it doesn't feed straight, try using the value at the center of the sheet and then 
compensating for the printer's drift with the stretch settings in the Printer Alignment dialog 
(accessible by clicking the "Alignment" button on the Print dialog). 
 
 
Print another test sheet with my revised settings: If you check this box, once you click the 
"Next" button, the wizard will print another copy of the alignment-test sheet with the horizontal 
and vertical adjustments you've entered on this page, so you can see if they produce a 
perfectly centered page. 
 
 
A Few Bonus Calibration Tips: 
 
* Make sure your paper fits snugly in the paper tray! If your paper has room to slide around 
inside the paper tray, there's a good chance that this will induce alignment errors. Checking 
this could eliminate the need for alignment correction altogether. 
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* If the alignment-test sheet indicates that your alignment is much worse than you expected, 
make sure you checked the correct paper-size option before you printed the sheet. The paper 
size that the wizard thinks you printed on will be noted near the top-left corner of the alignment 
test sheet. If you checked the A4 box but inserted a sheet of letter paper, for instance, the 
alignment sheet will obviously be off center. 
 
* Some printers will feed differently depending on the paper thickness. If you want to be 
absolutely sure you've got your alignment as accurate as possible, try printing the test sheet 
on a sheet of your actual label paper. This will cost you a sheet of your label paper, of course, 
so you may prefer to wait and see first whether you were able to compensate for your printer's 
alignment just by printing the test sheet on plain paper. If you do decide to print an alignment 
sheet on a sheet of label paper, make sure you've checked the right paper size setting. In 
particular, lots of DVD-case-cover sheets use A4 paper. If you're used to printing on letter-
sized paper, measure your DVD cover paper before you print an alignment test sheet on it to 
make sure you know what size it is.  
 
* Some printers just don't have consistent alignment. One printout will be off in one direction, 
and another will be off in a different direction. You can test for this by setting the "Number of 
Copies" control on the Test-Sheet page of the wizard to print multiple copies of the sheet. If 
each sheet has a different alignment error, you probably can't make alignment adjustments 
that will always work. Your best bet is probably to enter an average value on this page and 
then try to compensate for the printer's inconsistency with the stretch settings in the Printer 
Alignment dialog (accessible by clicking the "Alignment" button on the Print dialog). Acoustica 
CD/DVD Label Maker defaults to a stretch setting of two millimeters, which means that a label 
you print will be two millimeters taller and two millimeters wider than the actual size of the label 
on the sheet, in the hopes that this extra bleed area will prevent minor alignment problems 
from causing edges of the label not to get printed on. If your printer is a schizophrenic wreck 
and displays wildly different alignments from sheet to sheet, you might need to increase this 
value. 
 
 
* Since this wizard works by printing calibration tests on paper, it works well for handling 
alignment errors on label paper, but isn't suited for handling alignment errors for CD trays that 
you insert into your printer for printing directly onto printable CDs. To align your printable CDs, 
try using the "Edit Paper Templates" Dialog, which you can access from the "File" menu. 
 
Printer Alignment Wizard Intro Page 
Printer Alignment Wizard Test-Sheet Page 
Printer Alignment Wizard Finish Page 
 
Help Contents  
 
 
 
The Printer Calibration Wizard: Finish Page 

 
 
If you got this far, you've finished the calibration wizard. Congratulations! We had every 
confidence that you'd arrive. 
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If you printed a second test sheet to see how well the printer calibrates with your revised 
alignment settings, try the familiar fold-and-measure-the-creases routine again to see if your 
changes have improved matters. If you're happy with your adjustments, click the Finish button 
to close the wizard and save your changes. 
 
If you decided you don't need to make any changes here, just click the Cancel button to close 
the wizard without saving the alignment adjustments you made. 
 
If you want to keep fiddling with your alignment, you can click the Back button to change your 
alignment offsets again and reprint the test to see how it works. 
 
If for some reason you want to discard your changes but then apply them later in Acoustica 
CD/DVD Label Maker's Printer Alignment dialog, you'll need to know that the Printer Alignment 
dialog doesn't deal in negative numbers. Instead, negative offsets on the "Vertical Offset" axis 
correspond to the "up" direction on the Printer Alignment dialog and positive offsets 
correspond to the "down" direction, while negative offsets on the "Horizontal Offset" axis 
correspond to the "left" direction on the Printer Alignment dialog and positive offsets 
correspond to the "right" direction. 
 
Printer Calibration Wizard Intro Page 
Printer Calibration Wizard Test-Sheet Page 
Printer Calibration Wizard Alignment Page 
 
Help Contents  
 
 
 
Adjust an Image's Size & Position Dialog 

 
 

 
 
This dialog lets you change the size, position, and aspect-ratio preservation of an image 
you've added to a label. All units in this dialog are in millimeters. 
 
You can access this dialog by right-clicking on an image and selecting the "Adjust 
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Size/Position" option from the menu that pops up or by clicking on an image to select it and 
then selecting the "Adjust Size/Position" option from the Image menu. 
 
 
Distance from label top (mm): The distance from the top edge of the label to the top edge of 
your image. 
 
Distance from label left (mm): The distance from the left edge of the label to the left edge of 
your image. 
 
Width (mm): The width of your image, in millimeters. 
 
Height (mm): The height of your image, in millimeters.  
 
Preserve original aspect ratio: When this box is checked, if you change your image's height, 
the label maker will automatically adjust the width (or vice versa) so that the image's aspect 
ratio is preserved. If you uncheck this box, you can change your image's height or at will 
without affecting the image's width (or vice versa), and consequently make your image look as 
stretched or scrunched as you like. 
 
OK: Closes the dialog and saves your changes. 
 
Cancel: Closes the dialog and discards any changes you made in it. 
 
 
Help Contents 
 
 
 
 
Adjust a Shape's Size & Position Dialog 

 
 

 
 
This dialog lets you change the size, position, and aspect-ratio preservation of a shape you've 
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added to your label. All units in this dialog are in millimeters. 
 
You can access this dialog by right-clicking on a shape and selecting the "Adjust Size/Position" 
option from the menu that pops up or by clicking on a shape to select it and then selecting the 
"Adjust Size/Position" option from the Shape menu. 
 
Distance from label top (mm): The distance from the top edge of the label to the top edge of 
your shape. 
 
Distance from label left (mm): The distance from the left edge of the label to the left edge of 
your shape. 
 
Width (mm): The width of your shape, in millimeters. 
 
Height (mm): The height of your shape, in millimeters.  
 
Preserve original aspect ratio: When this box is checked, if you change your shape's height, 
Acoustica CD/DVD Label Maker will automatically adjust the width (or vice versa) so that the 
shape's height and width are always exactly equal. If you uncheck this box, you can change 
your shape's height at will without affecting the shape's width (or vice versa), and consequently 
make your shape as stretched or scrunched as you like. 
 
OK: Closes the dialog and saves your changes. 
 
Cancel: Closes the dialog and discards any changes you made in it. 
 
This dialog lets you set absolute positions for a shape without regard to where they're 
overlapping label boundaries, so you can end up moving a shape to be in the hole of a CD 
label, or outside the label altogether, so that it's not visible. If you do this accidentally (or 
purposely, and later change your mind), but you're unable to select the shape to move it, click 
on your label (to give it the keyboard focus), and then pressing the Tab key will cause focus to 
tab through all the objects on your label, and your shape will eventually get selected. 
 
Help Contents 
 
 
 
 
Why's the Align Menu Disabled? 

 
 
The Align menu aligns objects on your label. If you don't have an object selected, Acoustica 
CD/DVD Label Maker doesn't know what to align, so this menu will be disabled. 
 
Select a text object, shape, or image by clicking on it, and a selection frame will appear around 
it, indicating that the object is selected and that you can move it and resize it, among other 
things. Once you've selected an object, the options on the Align menu will be enabled and 
eagerly waiting for you to click on them. 
 
Bonus tip: If you're trying to align or justify the text within a text object, the Align menu isn't the 
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place to do it. Instead, launch* the Text Properties Dialog, then go to the Justification page of 
the dialog. If your text object isn't a Tracks object, its toolbar will also have a little justification 
control on it that you can use to quickly set the horizontal justification (for vertical justification, 
the Text Properties Dialog is your only option). 
 
* To launch the Text Properties dialog, you can either: 
   1) right-click on the text object and select the "Properties" option from the menu that pops up
   2) select the "Properties" option from the "Text" menu 
   3) or click the little button on the text object's toolbar that looks like a chevron 
 
 
Help Contents 
 
 
 
 
Why's the Text Menu Disabled? 

 
 
Because you haven't selected a text object to play with. Click on any text you've added to your 
label. This will make it the selected object, and it will grow a red sizing frame & titlebar, and a 
toolbar will appear underneath it. Now the Text menu should be enabled, and choices you 
make from this menu (excluding the "Create a new text object" option) will apply to the text 
you've selected. 
 
If you don't have any text on your label, try clicking on the "Text" button on the main toolbar or 
selecting the "Create a new text object" item from this menu to add some. 
 
 
Help Contents 
 
 
 
 
Why's the Image Menu Disabled? 

 
 
Because you haven't selected an image to play with. Click on any image you've added to your 
label as a foreground label (if you want to edit your label's background image, go to the 
Background menu instead). This will make the image the selected object, and it will grow a red 
sizing frame & titlebar, and a toolbar will appear underneath it. Now the Image menu should be 
enabled, and choices you make from this menu (excluding the choices for adding or 
downloading more art) will apply to the image you've selected. 
 
If you don't have any foreground images on your label, click on the "Art Search" or "Art 
Browse" tabs to add some. Once you've found an image there that you want to add to your 
label, just left-click on its thumbnail and drag it onto your label. 
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Help Contents 
 
 
 
 
Why's the Shape Menu Disabled? 

 
 
Because you haven't selected a shape object to play with. Click on any shape you've added to 
your label. This will make it the selected object, and it will grow a red sizing frame & titlebar, 
and a toolbar will appear underneath it. Now the Shape menu should be enabled, and choices 
you make from this menu (excluding the "Create a new shape object" option) will apply to the 
shape you've selected. 
 
If you don't have any shapes on your label, try clicking on the "shape" button on the main 
toolbar or selecting the "Create a new shape object" item from this menu to add some. 
 
 
Help Contents 
 
 
 
 
Why's the Background Menu Disabled? 

 
 
Because you haven't selected a background image for your CD label or insert. Most of the 
items on this menu apply to editing your background image, so if you don't have a background 
image, those menu items won't be available. 
 
To add a background image to your label, try one of these: 
 
* Click on the "Backgrounds" tab to browse through the backgrounds that come with the 
software, and just click on a thumbnail to make it your label background. 
 
* Click on the "Art Search" or "Art Browse" tabs to add your own art as a label background. 
(Once you've found an image here that you want to make your label background, either 
double-click on its thumbnail to make it a standard background, or right-click on it to see some 
of your other available options.) 
 
 
Help Contents 
 
 
 
 
Frequently Asked Questions 
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Printer Troubleshooting FAQ 
 
Can I print a label directly onto a CD? Where can i get label paper? 
 
How can I import my own graphics and put them on labels? 
 
I printed and nothing happened. 
 
How can I import the song titles from the CD I burned so I don't have to type them all in? 
 
 
Help Contents 
  
 
 
Can I print a label directly onto a CD? Where can I get label paper? 
 
There are a variety of printers available that can print directly onto a CD. Acoustica CD/DVD 
Label Maker currently supports several models from Epson, Canon, and Primera, among 
others. For direct-to-CD printing, you can't use regular CDs; you need to buy printable CDs 
instead. These are usually labeled as printable CDs and have a white surface.  
 
Several companies make CD label paper; you can find it at most large electronics stores and 
some large discount stores. If you're just starting out printing CD labels, we also recommend 
you buy a CD label applicator. It's a little plastic device, usually selling for a few dollars, that 
makes it much easier for you to get your labels aligned correctly on your CD.  
 
If you don't want to print jewel case labels on plain paper, you can buy premade jewel case 
label stock at the same places you find CD label paper. It's usually perforated and is thicker 
than typical printer paper. 
 
 
How can I import my own graphics and put them on labels? 
 
Acoustica CD/DVD Label Maker provides two ways to find images on your computer that you 
can add to your labels:  
 
1) Click on the "Art Search" tab, enter some text that's in the file or folder names of the art 
you're looking for, and click the "Search" button. Thumbnails of all supported image files 
matching your search terms will appear in the window underneath the search button. We 
support jpg, bmp, png, and pcx graphics types. 
 
2) Click on the "Art Browse" tab, and parse through the explorer tree to see thumbnails of all 
the supported image files in a particular folder. 
 
 
If you've found an image you want to make your background, you can do it one of these ways:
 
1) Double-left-click on the image's thumbnail to make it the background 
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or 
 
2) Ctrl + double-click the thumbnail to make it a tiled background 
 
or 
 
3) Right-click on the image's thumbnail and select one of the "Set as background" options. 
 
If the image you've selected doesn't have the same aspect ratio as the label you're putting it 
on, it may appear stretched or squished. It that's the case, you can left-click the image's 
thumbnail, drag it onto the label and release the mouse button, then click on the sizing bars to 
make it big enough to overlap the label without altering its aspect ratio, and click on its title bar 
or the image itself to position it where you want it. 
 
If you've found an image you want to add to your label as a piece of clip art (rather than as the 
label background), just left-click on its thumbnail, drag it onto your label, and release the 
mouse button. The program will place the image where you dropped it. As soon as you drop it, 
it should be in "selected" mode, with sizing bars and a toolbar. You can click on the image's 
sizing bars to resize the image; you can click on the image's title bar or the image itself to 
move it. You can also right-click on the image to pop up a menu with a variety of editing 
options. 
 
You can also drag image files from Windows Explorer and drop them onto your label, or paste 
them from the clipboard. 
 
 
 
I printed and nothing happened. 
 
If nothing came out of the printer, it's likely that you selected a different printer than the one 
you expected to print on. Click the "Print" toolbar button to launch the Print dialog, then check 
to see what printer is listed at the top of the dialog in the "name" field. Is this the printer you 
meant to print on? If not, set it to the correct one. 
 
If you got a blank page from the printer, you probably either tried to print a blank label - one 
you hadn't added any images, shapes,  or text to -- or your hard disk is nearly full. If your hard 
disk doesn't have at least 200 megabytes of free space, your printer driver is likely to have 
trouble creating the temporary files it needs to print with. 
 
 
How can I import the song titles from the CD I burned so I don't have to type them all in?
 
If you burned an audio CD, Acoustica CD/DVD Label Maker can usually import your song 
information from the playlist file you created with your CD Burner program. When you burned 
the CD, your CD Burning software should have created a file storing the names of all the song 
files that you were burning onto the CD. If you didn't save this list, please do so from now on -- 
it will save you lots of typing.  
 
If you click the "Tracks" button on the CD Label Maker's toolbar to launch the CD Contents 
dialog and then click the "Import" button on that dialog, the Label Maker will pop up a dialog 
that lets you find & select the playlist file you used to create your CD. Once you select the file, 
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the Label Maker will scan the playlist file, load your song information from it, and display it in 
the CD Contents dialog. 
 
If you burned your CD with the Acoustica MP3 CD Burner, you can click the "CD Label" button 
on the CD Burner's toolbar and the CD Burner will launch the Label Maker and automatically 
tell it the names, artists, and lengths of all your songs. If the Acoustica CD Burner asks if you 
want to save before it launches the Label Maker, click the "yes" button. 
 
Help ContentsWelcome  
 
 
 
 
 
Support 

 
 
If you need additional support for Acoustica CD/DVD Label Maker, please visit our web site at:
 
www.acoustica.com/support.htm 
 
 
Help Contents  
 
 
 
Purchase & Registration 

 
 
With the trial version of Acoustica CD/DVD Label Maker, the program will be fully functional 
until your trial expires. Once your trial expires, you won't be allowed to print labels again until 
you register your software.  
 
Why Register? 
 
* you can print as many labels as you want 
* tech support 
* free art! If you're registered you get access to more than 1,000 free backgrounds and 100 
themes, all designed exclusively for Acoustica CD/DVD Label Maker. 
* with your support, we can afford to add new features and make more high-quality, easy-to-
use software 
* it's easy 
 
You can buy a registration code now over the Internet and receive the code via e-mail within 
minutes. Just click the "Buy" button on the Label Maker's main toolbar or select the "Buy now 
and register" item from the Label Maker's Help menu.  
 
If you're not running Acoustica CD/DVD Label Maker right now, you can go directly to our 
website and purchase a code. Just click on this link:
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BUY NOW! 
 
And thanks for registering! We'll be proud to have you as a customer. 
 
 
Help Contents  
 
 
 
About Acoustica 

 
 
Address: 
Acoustica 
P.O. Box 728 
Oakhurst CA 93644 
USA 
 
Website: 
 
www.acoustica.com 
 
Info: 
Acoustica is located in California's Sierra foothills, near Yosemite National Park. We've been 
around since 1998. Our mission is to create fun, easy to use software that lets you get stuff 
done and enjoy doing it.  
 
 
Help Contents  
 
 
 
Credits 

 
 
Acoustica CD/DVD Label Maker Copyright © 2001-2006 Acoustica Inc. All Rights Reserved. 
 
Programming and design by Russ Cary, Joseph Clarke, and Brian Hughes. 
 
Featuring art by Rich Powell, Tim Ibbotson, Ramona Clarke, & Ronnie Nijmeh. 
 
Extra thanks to Ronnie Nijmeh, Lois Clarke, Donda Bird, Greg Birkel, and the Beta Team. 
 
Avery and all Avery brands, product names and codes are trademarks of Avery Dennison 
Corporation. For more information on Avery(r) products, call (800) 462-8379 in the U.S. or 
(888) 462-8379 in Canada, or visit www.avery.com. 
 
Lorenz Bell and all Lorenz Bell ® products, product names and codes are trademarks of 
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Lorenz Bell, Ltd. For more information about the products, visit www.lorenzbell.com. 
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